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Comms Manager 

Welcome to the online help and documentation for Comms Manager. 

Comms Manager manages, monitors, and displays NonStop server communications subsystems from a 
Windows workstation. 

More Information 
What's new 
Key features 
Managing Devices and TCP/IP 
Managing SLSA/WAN on S-Series 

 



 

Comms Manager Help The Operations Pack 4.0 Page 10 of 89 

What's new 

Hiding and Showing Objects 

Comms Manager help no longer includes information about hiding and showing objects. This information is 
now included in TOP help. 

This is because the capability to hide and show objects is no longer available from Comms Manager. TOP 
now includes the capability to create and manage user profiles that control access security to any system 
component available from TOP. Access security controls whether system components are hidden or 
displayed. 
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Key features 

More Information 
Supported Subsystems 
Displaying Communications Subsystem Status 
Displaying Object Information 
Managing Communications Objects 
Wizards 
More information 

Supported Subsystems 

You can manage the following standard Tandem communications susbsystems: 

 Bisync 

 Expand 

 Multilan 

 SNAX/XF 

 NonStop TCP/IP 

 TELNET 

 X25AM. 

On S-series Tandem computer systems, you can manage the following communications subsystems: 

 ServerNet LAN Systems Access (SLSA) 

 Wide Area Network (WAN) 

Displaying Communications Subsystem Status 

You can view a graphical snapshot of all standard communications environments in the main window. Large 
colourful bar graphs show the number of objects in various states at a glance. 

Displaying Object Information 

You can display general information and status information about objects, drilling down to gather more and 
more detailed information as required. 

Managing Communications Objects 

Comms Manager makes it easy to manage communications objects. Using Comms Manager you can list, 
add, copy, modify, delete, start, stop, and abort objects. 

Wizards 

Comms Manager provides wizards for quickly and easily performing various communications tasks. Using 
wizards you can: 

 Obtain the current status of specified objects and generate an SCF configuration script file to reinstate 
this object status after a cold load. 

 Obtain the current configuration of specified objects and generate an SCF configuration script file to 
reinstate this object configuration after a cold load. 

More information 

Comms Manager interacts with various Subsystem Control Facility (SCF) interfaces. For more information 
about a specific SCF interface, consult the Tandem manual that discusses the communications subsystem. 
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Managing Devices and TCP/IP 

More Information 
Reference information 
Tasks and tips 
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Reference information 

More Information 
Main window 
Logging on 
Preferences window 
Common windows 
Bisync Line Status window 
Expand windows 
Multilan windows 
Network windows 
SNAX/XF windows 
SSCP windows 
TCP/IP windows 
TELNET Server (Telserv) windows 
X.25 windows 
System Component Colors 

Main window 

The main window provides access to all Comms Manager menus, functions, and components. Colors 
indicate system component status. 

More Information 
Title bar Menu bar 
Session menu Object menu 
Wizard menu Help menu 
Communications Environment display Communications Objects box 
Status bar  

Menus and commands 

More Information 
Session menu 
Node menu 
Object menu 
Wizard menu 
Help menu 

Session menu 

The Session menu has the following commands for controlling your current session: 

Logon Displays the Logon window. Use this window to log on. 
Preferences Displays the Preferences window. Use this window to specify preferences. 
Exit Exits and logs you off. 

Node menu 

The Node menu has the following commands for managing nodes: 

Set Default Sets the default node displayed on the main window. 

Object menu 

The Object menu has the following commands for managing communications objects: 

List Displays a list of communication objects (all, in a certain state, or matching specific criteria). 

Wizard menu 

The Wizard menu has the following commands for quickly and easily performing tasks: 
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Script Starts the Script wizard. This wizard obtains the current status of specified objects and 
generates an SCF configuration script file to reinstate this object status after a cold load. 

Configuration Starts the Configuration wizard. This wizard obtains the current configuration of specified 
objects and generates an SCF configuration script file to reinstate this object configuration 
after a cold load. 

Help menu 

The Help menu has the following commands for getting help: 

Contents Displays the Contents topic. 
Help on Main Window Displays the Main window topic. 
Search for Help on Used to search through a list of selected topics. 
How to Use Help Displays the Contents for How to Use Help topic. 
About Displays contact and version information. 

Logging on 

More Information 
Configuration window 
Logon window 
Node Selection window 

Configuration window 

Use the Configuration window to specify the configuration parameters that Comms Manager uses to 
establish a session with the MIP from this workstation. 

 If the Logon History box from the Logon window shows one or more entries, you have previously 
established a session with the MIP. If so, Comms Manager uses the parameters of the most recent 
entry. Click any other entry to select that entry and use its parameters instead. 

 If the Logon History box from the Logon window is empty, either you have not previously established a 
session with the MIP or you have recently cleared the logon history information (for example, by clicking 
the Clear History button). You must specify the parameters you want to use before you can establish a 
session with the MIP. 

More Information 
Options box  

Logon window 

Use the Logon window to establish a session with the MIP from Comms Manager. The default configuration 
parameters used to establish the session are displayed in the Current Configuration box. 

More Information 
Current Configuration box Logon box 
Logon History box  

Node Selection window 

Use the Node Selection window to display and select nodes to use with Comms Manager. You must select 
at least one node. 

More Information 
Nodes box  

Preferences window 

Use the Preferences window to specify preferences. 

More Information 
Background SCF Server box Host Timeout box 
Interactive SCF Server box Refresh Interval box 
Defaults button  
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Common windows 

More Information 
List Specific Objects window 
Object List window 

List Specific Objects window 

Use the List Specific Objects window to specify the objects to list. Listed objects are displayed in the 
Object List window. 

More Information 
List field  

Object List window 

Use the Object List window to list information about communications objects in the specified state. Click an 
entry to select the entry. To select two or more entries in sequence, click the first entry, then press and hold 
down the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, 
press and hold down the Ctrl key and click each entry. 

Double-click to modify an entry, as follows: 

 Double-click an Expand entry to display the Expand Path Modify window. 
 Double-click an SSCP entry to display the SNAX/XF Subsys Modify window. 
 Double-click a SNAX/XF entry to display the SNAX/XF Line Modify window. 
 Double-click a TCP/IP entry to display the TCP/IP Process Modify window. 
 Double-click an X.25 entry to display the X.25 Line Modify window. 

More Information 
List box Abort button 
Modify button Start button 
Status button Stop button 

Bisync Line Status window 

Use the Bisync Line Status window to display status information about each Bisync line. Click an entry to 
select the entry. To select two or more entries in sequence, click the first entry, then press and hold down 
the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, press 
and hold down the Ctrl key and click each entry. 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Envoy. 

Expand windows 

This topic describes windows for working with the individual paths and lines in an Expand network. Use the 
Expand Network Map window to display a map of the Expand network. 

More Information 
Expand Line Info window 
Expand Line Modify window 
Expand Line Status window 
Expand Line Status Detail window 
Expand Path Info window 
Expand Path Modify window 
Expand Path Status window 
Expand Path Status Detail window 

For more information, refer to the SCF Reference Manual for Expand. 



 

Comms Manager Help The Operations Pack 4.0 Page 16 of 89 

Expand Line Info window 

Use an Expand Line Info window to display information about each Expand line. The appearance of the 
window depends on the type of line. 

More Information 
Expand Line Info window - Direct-Connect and Satellite-Connect 
Expand Line Info window - NAM 

For more information, refer to the SCF Reference Manual for Expand. 

Expand Line Info window - Direct-Connect and Satellite-Connect 

Use the Expand Line Info window to display information about each Expand line. Click an entry to select 
the entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift 
key and click the last entry in the sequence. To select two or more entries out of sequence, press and hold 
down the Ctrl key and click each entry. Double-click an entry to display the Expand Line Modify window. 

More Information 
List box Abort button 
Modify button Start button 
Status button Stop button 

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Info window - NAM 

Expand Line Info window - NAM 

Use the Expand Line Info window to display information about each Expand line. Click an entry to select 
the entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift 
key and click the last entry in the sequence. To select two or more entries out of sequence, press and hold 
down the Ctrl key and click each entry. Double-click an entry to display the Expand Line Modify window. 

More Information 
List box Abort button 
Modify button Start button 
Status button Stop button 

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Info window - Direct-Connect and Satellite-Connect 

Expand Line Modify window 

Use an Expand Line Modify window to modify the attributes of the selected Expand line. The appearance 
of the window depends on the L2 protocol of the Expand line you are modifying. 

More Information 
Expand Line Modify window - L2 Css^Net^Direct Protocol 
Expand Line Modify window - L2 Net^Direct Protocol 
Expand Line Modify window - L2 Net^IP Protocol 
Expand Line Modify window - L2 Net^Nam Protocol 

For more information, refer to the SCF Reference Manual for Expand. 

Expand Line Modify window - L2 Css^Net^Direct Protocol 

Use the Expand Line Modify window to modify the attributes of the selected Expand line. 

More Information 
Address field Autoload field 
CLBdwnloadRetries field CLBdwnloadTimer field 
Clockmode field Clockspeed field 
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Delay field DRtimeout field 
Dsrtimer field Flagfill field 
Framesize field IdleTimeout field 
Interface field L2Protocol field 
L2Retries field L2Timeout field 
LineBufSize field Program field 
Protocolid field Readbuffers field 
Rsize field Speed field 
Startup field Testint field 
Threshold field Txwindow field 

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Modify window - L2 Net^Direct protocol 
Expand Line Modify window - L2 Net^IP protocol 
Expand Line Modify window - L2 Net^Nam protocol 

Expand Line Modify window - L2 Net^Direct Protocol 

Use the Expand Line Modify window to modify the attributes of the selected Expand line. 

More Information 
Address field Delay field 
DriverName field Flagfill field 
Framesize field Idletimeout field 
Interface field L2DiscardOnReset field 
L2Protocol field L2Retries field 
L2Timeout field LineBufSize field 
Readbuffers field Rsize field 
Speed field Startup field 
Threshold field TxWindow field 

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Modify window - L2 Css^Net^Direct protocol 
Expand Line Modify window - L2 Net^IP protocol 
Expand Line Modify window - L2 Net^Nam protocol 

Expand Line Modify window - L2 Net^IP Protocol 

Use the Expand Line Modify window to modify the attributes of the selected Expand line. 

More Information 
AfterMaxRetries Associatedev 
Associatesubdev Delay 
DestIpAddr DestIpPort 
Framesize L2Protocol 
L2Timeout Maxreconnects 
Retryprobe Rsize 
Rxwindow Speed 
SrcIpAddr SrcIpPort 
Startup Timerinactivity 
Timerprobe Timerreconnect 
TxWindow  

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Modify window - L2 Css^Net^Direct protocol 
Expand Line Modify window - L2 Net^Direct protocol 
Expand Line Modify window - L2 Net^Nam protocol 
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Expand Line Modify window - L2 Net^Nam Protocol 

Use the Expand Line Modify window to modify the attributes of the selected Expand line. 

More Information 
AfterMaxRetries field Associatedev field 
Associatesubdev field Connecttype field 
Delay field Framesize field 
L2Protocol field L2Timeout field 
Maxreconnects field Retryprobe field 
Rsize field Rxwindow field 
Speed field Startup field 
Timerbind field Timerinactivity field 
Timerprobe field Timerreconnect field 
TxWindow field  

For more information, refer to the SCF Reference Manual for Expand. 

Related Information 
Expand Line Modify window - L2 Css^Net^Direct protocol 
Expand Line Modify window - L2 Net^Direct protocol 
Expand Line Modify window - L2 Net^IP protocol 

Expand Line Status window 

Use the Expand Line Status window to display status information about each Expand line. Click an entry to 
select the entry. To select two or more entries in sequence, click the first entry, then press and hold down 
the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, press 
and hold down the Ctrl key and click each entry. Double-click an entry to display the Expand Line Modify 
window. 

More Information 
List box Abort button 
Details button Modify button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Expand. 

Expand Line Status Detail window 

Use the Expand Line Status Detail window to display detailed status information for the selected Expand 
line. The appearance of the window depends on the type of line. 

More Information 
Backup box CIU-Path 
CLIP box CSM-LDEV 
Detailed State Path LDEV box 
Primary box State box 
Trace box  

For more information, refer to the SCF Reference Manual for Expand. 

Expand Path Info window 

Use the Expand Path Info window to display information about each Expand path. 

More Information 
List box Abort button 
Lines button Modify button 
Start button Status button 
Stop button  

For more information, refer to the SCF Reference Manual for Expand. 
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Expand Path Modify window 

Use the Expand Path Modify window to modify the attributes of the selected Expand path. 

More Information 
Compress field L4CongCtrl field 
L4ExtPackets field L4Retries field 
L4SendWindow field L4Timeout field 
Nextsys field OSSpace field 
OSTimeout field PathBlockBytes field 
PathPacketBytes field Superpath field 
Timefactor field  

For more information, refer to the SCF Reference Manual for Expand. 

Expand Path Status window 

Use the Expand Path Status window to display status information about each Expand path. 

More Information 
List box Abort button 
Details button Lines button 
Modify button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for Expand. 

Expand Path Status Detail window 

Use the Expand Path Status Detail window to display detailed status information about the selected 
Expand path. 

More Information 
Backup box CLIP box 
Lines box Number of Lines box  
Primary box State box 
Trace box  

For more information, refer to the SCF Reference Manual for Expand. 

Multilan windows 

More Information 
Multilan Line Info window 
Multilan Line Status window 

For more information, refer to the SCF Reference Manual for Multilan and the SCF Reference Manual for 
TLAM. 

Multilan Line Info window 

Use the Multilan Line Info window to display information about each Multilan line. 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Multilan and the SCF Reference Manual for 
TLAM. 

Multilan Line Status window 

Use the Multilan Line Status window to display status information about each Multilan line. 

More Information 
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List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Multilan and the SCF Reference Manual for 
TLAM. 

Network windows 

This topic describes windows that display a map of the Expand network. Use the Expand windows to work 
with the individual paths and lines in an Expand network. 

More Information 
Expand Network Map window 

For more information, refer to the SCF Reference Manual for Expand. 

Expand Network Map window 

Use the Expand Network Map window to display a map of the Expand network from the perspective of the 
current system. 

More Information 
Systems box  
Systems field List box 
  
Linesets box  
Linesets field List box 
Abort button Details button 
Modify button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for Expand. 

SNAX/XF windows 

More Information 
SNAX/XF Line Add window 
SNAX/XF Line Info window 
SNAX/XF Line Modify window 
SNAX/XF Line Status window 
SNAX/XF LU Add/Copy/Modify window 
SNAX/XF LU Info window 
SNAX/XF LU Status window 
SNAX/XF PU Add/Copy/Modify window 
SNAX/XF PU Info window 
SNAX/XF PU Status window 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF Line Add window 

Use the SNAX/XF Line Add window to add a SNAX line. 

More Information 
List box  

SNAX/XF Line Info window 

Use the SNAX/XF Line Info window to display information about each SNAX line. 

More Information 
List box Abort button 
Add button Delete button 
LUs button Modify button 
PUs button Start button 
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Stop button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF Line Modify window 

Use the following tabs of the SNAX/XF Line Modify window to modify SNAX/XF lines: 

More Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
SNAX/XF Line Modify window - 36xx 2 tab 
SNAX/XF Line Modify window - 3605,3650 tab 
SNAX/XF Line Modify window - SapInfo tab 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF Line Modify window - General1 tab 

Use the SNAX/XF Line Modify window - General1 tab to modify general attributes of a SNAX/XF line. 

More Information 
BindEntry field BindTable field 
BPoolPages field CharacterSet field 
DialType field Interface field 
IOPages field LinkStationMode field 
MaxLUs field MaxPUs field 
RecSize field ServiceManager field 
SMdmLossFatal field Station field 
Switched field SwOpmsg field 
SwSessTimeout field Type field 
Version field XPages field 
PUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
SNAX/XF Line Modify window - 36xx 2 tab 
SNAX/XF Line Modify window - 3605,3650 tab 
SNAX/XF Line Modify window - SapInfo tab 

SNAX/XF Line Modify window - General2 tab 

Use the SNAX/XF Line Modify window - General2 tab to modify general attributes of a SNAX/XF line. 

More Information 
Applid field AssociateSubdev field 
AutoAccept field AutoLogon field 
ConnectAppl field EssTable field 
LUOpMsg field MaxConfig field 
MaxConfigXPages field MaxLocalLUs field 
MaxRcvSize field MdmLossFatal field 
MdmLossFatalTimer field NoAcq field 
PUIdBlk field PUIdNum field 
SMaxLUs field SMaxPUs field 
PUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
SNAX/XF Line Modify window - 36xx 2 tab 
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SNAX/XF Line Modify window - 3605,3650 tab 
SNAX/XF Line Modify window - SapInfo tab 

SNAX/XF Line Modify window - 36xx 1 tab 

Use the SNAX/XF Line Modify window - 36xx 1 tab to modify 36xx attributes of a SNAX/XF line. 

More Information 
AutoTestResp field Burst field 
DSRTimeOut field Duplex field 
FcsErrReportFreq field FlagFill field 
IBMCuAddr field L2Option1 field 
Pollint field Retries field 
RNRReceive field RNRSend field 
RNRTimer field SnrmlFdm field 
PUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 2 tab 
SNAX/XF Line Modify window - 3605,3650 tab 
SNAX/XF Line Modify window - SapInfo tab 

SNAX/XF Line Modify window - 36xx 2 tab 

Use the SNAX/XF Line Modify window - 36xx 2 tab to modify 36xx attributes of a SNAX/XF line. 

More Information 
Speed field SpXID field 
SupFcsErrMsg field Timeout field 
TWS field Window field 
XmtTimeout field PUs button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
SNAX/XF Line Modify window - 3605,3650 tab 
SNAX/XF Line Modify window - SapInfo tab 

SNAX/XF Line Modify window - 3605,3650 tab 

Use the SNAX/XF Line Modify window - 3605,3650 tab to modify 3605 and 3650 attributes of a SNAX/XF 
line. 

More Information 
AutoLoad field Debug field 
NetId field Prog9370 field 
Program field X21Nrdy field 
X21T1Timeout field X21T2Timeout field 
X21T3aTimeout field X21T3bTimeout field 
X21T4Timeout field X21T5Timeout field 
X21T6Timeout field X21T7Timeout field 
PUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
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SNAX/XF Line Modify window - 36xx 2 tab 
SNAX/XF Line Modify window - SapInfo tab 

SNAX/XF Line Modify window - SapInfo tab 

Use the SNAX/XF Line Modify window - SapInfo tab to modify general attributes of a SNAX/XF line. 

More Information 
List box Add button 
Modify button Delete button 
PUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF Line Modify window - General1 tab 
SNAX/XF Line Modify window - General2 tab 
SNAX/XF Line Modify window - 36xx 1 tab 
SNAX/XF Line Modify window - 36xx 2 tab 
SNAX/XF Line Modify window - 3605,3650 tab 

SNAX/XF Line Status window 

Use the SNAX/XF Line Status window to display status information about each SNAX line. 

More Information 
List box Abort button 
LUs button Modify button 
PUs button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF LU Add/Copy/Modify window 

Use the SNAX/XF LU Add/Copy/Modify window to add, copy, or modify an LU. 

More Information 
LU field (Add/Copy only) ActLU field 
Address field AllowedMix field 
Associate field AutoLogon field 
BindEntry field BindTable field 
CDI field CharacterSet field 
Dbcs field DevType field 
ERMode field EssTable field 
INITSELFACTION field LUDisabled field 
LUPartner field NoAcq field 
NT21 field PassThru field 
Protocol field PUName field 
Recsize field Static field 
SwLUType field Type field 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF LU Info window 

Use the SNAX/XF LU Info window to display information about each logical unit (LU). 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 
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SNAX/XF LU Status window 

Use the SNAX/XF LU Status window to display status information about each logical unit (LU). 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF PU Add/Copy/Modify window 

Use the following tabs of the SNAX/XF PU Add/Copy/Modify window to add, copy, or modify SNAX/XF 
PUs: 

More Information 
SNAX/XF PU Add/Copy/Modify window - General tab 
SNAX/XF PU Add/Copy/Modify window - X.25 and Token-Ring tab 
SNAX/XF PU Add/Copy/Modify window - Token-Ring tab 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF PU Add/Copy/Modify window - General tab 

Use the SNAX/XF PU Add/Copy/Modify window - General tab to add, copy, or modify general PU 
attributes. 

More Information 
PU field (Add/Copy only) ActPU field 
Address field AutoLogon field 
BindEntry field BindTable field 
EssTable field L3Retry field 
L3Timeout field MaxLUs field 
MaxPTS field NoAcq field 
PUIdBlk field PUIdNum field 
Recsize field ReqdiscontType field 
Reqms field ServiceCount field 
SwPUType field Type field 
Window field LUs button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF PU Add/Copy/Modify window - X.25 and Token-Ring tab 
SNAX/XF PU Add/Copy/Modify window - Token-Ring tab 

SNAX/XF PU Add/Copy/Modify window - X.25 and Token-Ring tab 

Use the SNAX/XF PU Add/Copy/Modify window - X.25 and Token-Ring tab to add, copy, or modify X.25 
and token-ring PU attributes. 

More Information 
PU field (Add/Copy only) AssociateSubdev field 
CallAddr field CallValidate field 
ConnId field LUs button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF PU Add/Copy/Modify window - General tab 
SNAX/XF PU Add/Copy/Modify window - Token-Ring tab 

SNAX/XF PU Add/Copy/Modify window - Token-Ring tab 

Use the SNAX/XF PU Add/Copy/Modify window - Token-Ring tab to add, copy, or modify token-ring PU 
attributes. 
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More Information 
PU field (Add/Copy only) TrMaxIn field 
TrMaxOut field TrMaxOutIncr field 
TrMaxRetry field TrRmtAddr field 
TrSsap field TrT1 field 
TrT2 field TrTI field 
LUs button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

Related Information 
SNAX/XF PU Add/Copy/Modify window - General tab 
SNAX/XF PU Add/Copy/Modify window - X.25 and Token-Ring tab 

SNAX/XF PU Info window 

Use the SNAX/XF PU Info window to display information about each physical unit (PU). 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF PU Status window 

Use the SNAX/XF PU Status window to display status information about each physical unit (PU). 

More Information 
List box Abort button 
LUs button Modify button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SSCP windows 

More Information 
SNAX/XF Subsys Info window 
SNAX/XF Subsys Status window 
SNAX/XF Subsys Modify window 

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF Subsys Info window 

Use the SNAX/XF Subsys Info window to display information about each SNAX subsystem. 

More Information 
List box Lines button 
Modify button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

SNAX/XF Subsys Status window 

Use the SNAX/XF Subsys Status window to display status information about each SNAX subsystem. 

More Information 
List box Lines button 
Modify button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 
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SNAX/XF Subsys Modify window 

Use the SNAX/XF Subsys Modify window to modify the selected SNAX subsystem. 

More Information 
CpName field SetTab field 
SnaNetId field SscpId field 
Version field XPages field 
Lines button  

For more information, refer to the SCF Reference Manual for SNAX/XF. 

TCP/IP windows 

More Information 
TCP/IP Process Add window 
TCP/IP Process Info window 
TCP/IP Process Modify window 
TCP/IP Process Status window 
TCP/IP Process Status Detail window 
TCP/IP Route Add/Copy window 
TCP/IP Route Details window 
TCP/IP Route Info window 
TCP/IP Route Status window 
TCP/IP Subnet Add/Copy window 
TCP/IP Subnet Info window 
TCP/IP Subnet Modify window 
TCP/IP Subnet Status window 

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Process Add window 

Use the TCP/IP Process Add window to add a TCP/IP process. 

More Information 
CPU field Debug field 
Def Mode field Extended Swap field 
High Pin field Home Terminal field 
In field Inspect field 
Library field Mem field 
Out field PFS field 
Priority field Process field 
Program Filename field QIO Limit field 
Swap field  

For more information, refer to the TACL Reference Manual and the SCF Reference Manual for Tandem 
NonStop TCP/IP. 

TCP/IP Process Info window 

Use the TCP/IP Process Info window to display information about each TCP/IP process. Click an entry to 
select the entry. To select two or more entries in sequence, click the first entry, then press and hold down 
the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, press 
and hold down the Ctrl key and click each entry. Double-click an entry to display the TCP/IP Process Modify 
window. 

More Information 
List box Abort button 
Modify button Routes button 
Status button Stop button 
Subnets button  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 
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TCP/IP Process Modify window 

Use the TCP/IP Process Modify window to modify TCP/IP process attributes. 

More Information 
All Nets Are Local field Debug field 
Delay Ack field Delay Ack Time field 
Full Dump field Host ID field 
Host Name field Keep Alive Idle field 
Keep Alive Interval field Keep Alive Retry Cnt field 
Program Filename field QIO Limit field 
TCP Compat 42 field TCP Receive Space field 
TCP Send Space field UDP Receive Space field 
UDP Send Space field Subnets button 
TCP Path MTU field TCP Time Wait field 
Trace Status field Trace Filename field 

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Process Status window 

Use the TCP/IP Process Status window to display status information for each TCP/IP process. Click an 
entry to select the entry. To select two or more entries in sequence, click the first entry, then press and hold 
down the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, 
press and hold down the Ctrl key and click each entry. Double-click an entry to display the TCP/IP Process 
Modify window. 

More Information 
List box Abort button 
Details button Modify button 
Routes button Stop button 
Subnets button  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Process Status Detail window 

Use the TCP/IP Process Status Detail window to display detailed status information for each TCP/IP 
process socket. 

More Information 
Backup PID field List box 
Primary PID field Status field 
Modify button Subnets button 
Routes button  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Route Add/Copy window 

Use the TCP/IP Route Add/Copy window to add or copy a TCP/IP route. 

More Information 
Destination field Gateway field 
Route field Type field 
Start Route field  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Route Details window 

Use the TCP/IP Route Details window to display detailed information for the selected TCP/IP route. 

More Information 
Destination field Gateway field 
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Subnetname field Type field 

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Route Info window 

Use the TCP/IP Route Info window to display information for each TCP/IP route. Click an entry to select the 
entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift key 
and click the last entry in the sequence. To select two or more entries out of sequence, press and hold down 
the Ctrl key and click each entry. Double-click an entry to display the TCP/IP Route Details window. 

More Information 
List box Abort button 
Add button Copy button 
Delete button Details button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Route Status window 

Use the TCP/IP Route Status window to display status information for each TCP/IP route. Click an entry to 
select the entry. To select two or more entries in sequence, click the first entry, then press and hold down 
the Shift key and click the last entry in the sequence. To select two or more entries out of sequence, press 
and hold down the Ctrl key and click each entry. Double-click an entry to display the TCP/IP Route Details 
window. 

More Information 
List box Abort button 
Details button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Subnet Add/Copy window 

Use the TCP/IP Subnet Add/Copy window to add or copy a TCP/IP subnet. 

More Information 
Devicename field IPAddress field 
IRDP field QIO field 
Subnet field Type field 
Start Subnet field  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Subnet Info window 

Use the TCP/IP Subnet Info window to display information for each TCP/IP subnet. Click an entry to select 
the entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift 
key and click the last entry in the sequence. To select two or more entries out of sequence, press and hold 
down the Ctrl key and click each entry. Double-click an entry to display the TCP/IP Subnet Modify window. 

More Information 
List box Abort button 
Add button Copy button 
Delete button Modify button 
Routes button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Subnet Modify window 

Use the TCP/IP Subnet Modify window to modify a TCP/IP subnet. 
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More Information 
Devicename field IPAddress field 
IRDP field QIO field 
Subnetmask field SUName field 
Type field  

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TCP/IP Subnet Status window 

Use the TCP/IP Subnet Status window to display status information for each TCP/IP subnet. 

More Information 
List box Abort button 
Modify button Routes button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Tandem NonStop TCP/IP 

TELNET Server (Telserv) windows 

More Information 
TELNET Process Add window 
TELNET Process Info window 
TELNET Process Modify window 
TELNET Process Status window 
TELNET Service Add/Copy/Modify/Details window 
TELNET Service Info window 
TELNET Window Add/Copy/Modify window 
TELNET Window Info window 
TELNET Window Status window 

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Process Add window 

Use the TELNET Process Add window to add a TELNET process. 

More Information 
Banner field CPU field 
Data Bits field Debug field 
Def Mode field Extended Swap field 
High Pin field Home Terminal field 
In field Inspect field 
Library field Mem field 
Menu field Out field 
PFS field Port field 
Priority field Process field 
Program Filename field Prompt field 
Swap field TACL field 

For more information, refer to the TACL Reference Manual and the Telserv Guide. 

TELNET Process Info window 

Use the TELNET Process Info window to display information about each TELNET process. 

More Information 
List box Abort button 
Modify button Status button 
Stop button Windows button 

For more information, refer to the SCF Reference Manual for Telserv. 
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TELNET Process Modify window 

Use the TELNET Process Modify window to modify a TELNET process. 

More Information 
Backup box CPU List box 
Max Terminals field Menu field 
Port field Primary box 
Program field TACL field 
Timeout Value field Total Services field 
Total Terminals field Transport Process field 
Transport Type field Services button 
Windows button  

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Process Status window 

Use the TELNET Process Status window to display status information about each TELNET process. 

More Information 
List box Abort button 
Stop button Windows button 

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Service Add/Copy/Modify/Details window 

Use the TELNET Service Add/Copy/Modify/Details window to add, copy, modify, or display detailed 
information about a TELNET service. 

Note  You cannot modify a TACL service or system services (these service names begin with Z). 

More Information 
Access box Assigned box 
Autodelete box CPU box 
Default box Display box 
Lib box Owner box 
Param box Pri box 
Program box Resilient box 
Service box (Add/Copy only) Subtype box 
Swap box Type box 
Windows button  

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Service Info window 

Use the TELNET Service Info window display information about each TELNET service. 

More Information 
List box Add button 
Copy button Delete button 
Modify button Windows button 

Note  You cannot delete a TACL service or system services (these service names begin with Z). 

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Window Add/Copy/Modify window 

Use the TELNET Window Add/Copy/Modify window to add, copy, or modify a TELNET window. 

More Information 
Window field (Add/Copy only) End-of-File field 
End-of-Line field Erase field 
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Interrupt field Kill-Line field 
Local Address field (Modify only) Remote Address field (Modify only) 
Service Name field Service Type field 
Start Window field  

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Window Info window 

Use the TELNET Window Info window to display information about each TELNET window. 

More Information 
List box Abort button 
Add button Copy button 
Delete button Modify button 
Start button Status button 
Stop button  

For more information, refer to the SCF Reference Manual for Telserv. 

TELNET Window Status window 

Use the TELNET Window Status window to display status information about each TELNET window. 

More Information 
List box Abort button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for Telserv. 

X.25 windows 

More Information 
X.25 Line Info window 
X.25 Line Modify window 
X.25 Line Status window 
X.25 Line Status Detail window 
X.25 SU Info window 
X.25 SU Add/Copy/Modify window 
X.25 SU Status window 

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 Line Info window 

Use the X.25 Line Info window to display information about each X.25 line. Click an entry to select the entry. 
To select two or more entries in sequence, click the first entry, then press and hold down the Shift key and 
click the last entry in the sequence. To select two or more entries out of sequence, press and hold down the 
Ctrl key and click each entry. Double-click an entry to display the X.25 Line Modify window. 

More Information 
List box Abort button 
Modify button Start button 
Status button Stop button 
SUs button  

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 Line Modify window 

Use the following tabs of the X.25 Line Modify window to modify an X.25 line: 

More Information 
X.25 Line Modify window - Packet level tab 
X.25 Line Modify window - Link level tab 
X.25 Line Modify window - Tandem tab 
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X.25 Line Modify window - Optional tab 
X.25 Line Modify window - PAD tab 

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 Line Modify window - Packet level tab 

Use the X.25 Line Modify window - Packet level tab to modify the packet level attributes of an X.25 line. 

More Information 
CallingAddr field Calls field 
CharacterSet field Extformat field 
L3mod field L3window field 
Netid field PacketSize field 
PVCrange field SrcAddr field 
SVCrange field SUs button 

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 Line Modify window - Link level tab 
X.25 Line Modify window - Tandem tab 
X.25 Line Modify window - Optional tab 
X.25 Line Modify window - PAD tab 

X.25 Line Modify window - Link level tab 

Use the X.25 Line Modify window - Link level tab to modify the frame level attributes of an X.25 line. 

More Information 
DSRTimeout field Framemode field 
IdleTimeout field Interface field 
Retries field SYNCS field 
T1Timeout field Threshold field 
SUs button  

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 Line Modify window - Packet level tab 
X.25 Line Modify window - Tandem tab 
X.25 Line Modify window - Optional tab 
X.25 Line Modify window - PAD tab 

X.25 Line Modify window - Tandem tab 

Use the X.25 Line Modify window - Tandem tab to modify the Tandem-specific attributes of an X.25 line. 

More Information 
Clockmode field Clockspeed field 
Debug field Program field 
Type field SUs button 

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 Line Modify window - Packet level tab 
X.25 Line Modify window - Link level tab 
X.25 Line Modify window - Optional tab 
X.25 Line Modify window - PAD tab 

X.25 Line Modify window - Optional tab 

Use the X.25 Line Modify window - Optional tab to modify optional attributes of an X.25 line. 

More Information 
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BCUG field CUG field 
CUGType field RPOA field 
TransitDelay field SUs button 

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 Line Modify window - Packet level tab 
X.25 Line Modify window - Link level tab 
X.25 Line Modify window - Tandem tab 
X.25 Line Modify window - PAD tab 

X.25 Line Modify window - PAD tab 

Use the X.25 Line Modify window - PAD tab to modify pad attributes. 

More Information 
Bpadparms field Cpadparms field 
SUs button  

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 Line Modify window - Packet level tab 
X.25 Line Modify window - Link level tab 
X.25 Line Modify window - Tandem tab 
X.25 Line Modify window - Optional tab 

X.25 Line Status window 

Use the X.25 Line Status window to display status information for each X.25 line. Click an entry to select 
the entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift 
key and click the last entry in the sequence. To select two or more entries out of sequence, press and hold 
down the Ctrl key and click each entry. Double-click an entry to display the X.25 Line Modify window. 

More Information 
List box Abort button 
Details button Modify button 
Start button Stop button 
SUs button  

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 Line Status Detail window 

Use the X.25 Line Status Detail window to display detailed status information for the X.25 line. 

More Information 
Backup box Circuits box 
CIU Path box CSM-LDEV box 
CTS box DCD box 
Device type box DSR box 
InUse box LDEV box 
LinkState box NumSU box 
Primary box State box 

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 SU Info window 

Use the X.25 SU Info window to display information about each subdevice (SU). Click an entry to select the 
entry. To select two or more entries in sequence, click the first entry, then press and hold down the Shift key 
and click the last entry in the sequence. To select two or more entries out of sequence, press and hold down 
the Ctrl key and click each entry. Double-click an entry to display the X.25 Line Modify window. 

More Information 
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List box Abort button 
Add button Copy button 
Delete button Modify button 
Start button Stop button 

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 SU Add/Copy/Modify window 

Use the following tabs of the X.25 SU Add/Copy/Modify window to add, copy, or modify an X.25 subdevice 
unit (SU): 

More Information 
X.25 SU Add/Copy/Modify window - General1 tab 
X.25 SU Add/Copy/Modify window - General2 tab 
X.25 SU Add/Copy/Modify window - OSI tab 
X.25 SU Add/Copy/Modify window - Optional tab 
X.25 SU Add/Copy/Modify window - PAD tab 

For more information, refer to the SCF Reference Manual for X25AM. 

X.25 SU Add/Copy/Modify window - General1 tab 

Use the X.25 SU Add/Copy/Modify window - General1 tab to add, copy, or modify the first group of general 
characteristics of an X.25 subdevice unit (SU). 

More Information 
SU field (Add/Copy only) AssociateLine field 
DestAddr field Devtype field 
Port field Protocol field 
PVC field Recsize field 
RexmitTimeout field  

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 SU Add/Copy/Modify window - General2 tab 
X.25 SU Add/Copy/Modify window - OSI tab 
X.25 SU Add/Copy/Modify window - Optional tab 
X.25 SU Add/Copy/Modify window - PAD tab 

X.25 SU Add/Copy/Modify window - General2 tab 

Use the X.25 SU Add/Copy/Modify window - General2 tab to add, copy, or modify the second group of 
general characteristics of an X.25 subdevice unit (SU). 

More Information 
SU field (Add/Copy only) Nullfill field 
Page6520BlkSize field Parity field 
ParityChk field Pricall field 
RemoteNet field Thruput field 

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 SU Add/Copy/Modify window - General1 tab 
X.25 SU Add/Copy/Modify window - OSI tab 
X.25 SU Add/Copy/Modify window - Optional tab 
X.25 SU Add/Copy/Modify window - PAD tab 

X.25 SU Add/Copy/Modify window - OSI tab 

Use the X.25 SU Add/Copy/Modify window - OSI tab to add, copy, or modify Open Systems 
Interconnection (OSI) characteristics of an X.25 subdevice unit (SU). 

More Information 
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SU field (Add/Copy only) LocalAddrExt field 
LocalAddrExtType field RemoteAddrExt field 
RemoteAddrExtType field  

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 SU Add/Copy/Modify window - General1 tab 
X.25 SU Add/Copy/Modify window - General2 tab 
X.25 SU Add/Copy/Modify window - Optional tab 
X.25 SU Add/Copy/Modify window - PAD tab 

X.25 SU Add/Copy/Modify window - Optional tab 

Use the X.25 SU Add/Copy/Modify window - Optional tab to add, copy, or modify optional characteristics 
of an X.25 subdevice unit (SU). 

More Information 
SU field (Add/Copy only) AcceptChg field 
BCUG field CUD field 
CUG field CUGType field 
Negotiate box ReverseChg field 
RPOA field TransitDelay field 

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 SU Add/Copy/Modify window - General1 tab 
X.25 SU Add/Copy/Modify window - General2 tab 
X.25 SU Add/Copy/Modify window - OSI tab 
X.25 SU Add/Copy/Modify window - PAD tab 

X.25 SU Add/Copy/Modify window - PAD tab 

Use the X.25 SU Add/Copy/Modify window - PAD tab to add, copy, or modify pad characteristics. 

More Information 
SU field (Add/Copy only) Bpadparms field 
Cpadparms field  

For more information, refer to the SCF Reference Manual for X25AM. 

Related Information 
X.25 SU Add/Copy/Modify window - General1 tab 
X.25 SU Add/Copy/Modify window - General2 tab 
X.25 SU Add/Copy/Modify window - OSI tab 
X.25 SU Add/Copy/Modify window - Optional tab 

X.25 SU Status window 

Use the X.25 SU Status window to display status information for each subdevice (SU). 

More Information 
List box Abort button 
Modify button Start button 
Stop button  

For more information, refer to the SCF Reference Manual for X25AM. 

System Component Colors 

In the main window, colors indicate system component status. Possible colors are: 

Green Objects are started. 
Cyan Objects are starting. 
Yellow Objects are stopped. 
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Red Objects are in error. 
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Tasks and tips 

More Information 
Startup Options 
Listing Objects 
Adding an Object 
Copying an Object 
Modifying an Object 
Deleting an Object 
Starting an Object 
Stopping an Object 
Aborting an Object 
Displaying Object Info 
Displaying Object Status 
Displaying Detailed Object Status 

Startup Options 

More Information 
Starting On a Single Node 
Starting On Multiple Nodes 

Starting On a Single Node 

To start Comms Manager on a single node: 
1 Obtain, install, and start the MIP on the Tandem computer system with which you intend to use Comms 

Manager. Refer to the MIP documentation for details. 

2 Establish communication between the workstation from which you intend to run Comms Manager and 
the Tandem system. Refer to your communications or Tandem system documentation for details. 

3 Start Comms Manager. The Logon window is displayed. 

4 Type your user ID and password in the User ID and Password fields, respectively. 

5 If necessary, configure communications between Comms Manager and the Tandem system with which 
you intend to use Comms Manager. To do so click the Configure button to display the Configuration 
window, complete the appropriate options, and click the OK button. The Logon window is redisplayed. 

6 Click the OK button to begin the logon operation. 

7 If the Node Selection window is displayed, confirm that the node to which you want to log on is the only 
node selected. 

8 Click the OK button to continue the logon operation. Comms Manager attempts to log on using the 
specified user ID and password. Comms Manager displays a message if an error occurs (for example, 
an invalid user ID and password combination). When you have successfully logged on, Comms 
Manager displays the main window. 

Starting On Multiple Nodes 

To start Comms Manager on multiple nodes: 
1 Obtain, install, and start a MIP on the Tandem computer system with which you intend to directly use 

Comms Manager. This system is called the gateway node. Refer to the MIP documentation for details. 

2 Install and start a MIP on each other Tandem system with which you intend to use Comms Manager. 
These systems are called outer nodes. These nodes must be licensed to use Comms Manager online 
and must be connected by an Expand link to the gateway node. 

3 Establish communication between the workstation from which you intend to run Comms Manager and 
the gateway node. Refer to your communications or Tandem system documentation for details. 

4 Start Comms Manager from the workstation connected to gateway node. The Logon window is 
displayed. 
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5 Type your user ID and password in the User ID and Password fields, respectively. 

6 If necessary, configure communications between Comms Manager and the gateway node. To do so 
click the Configure button to display the Configuration window, complete the appropriate options, and 
click the OK button. The Logon window is redisplayed. 

7 Click the OK button to begin the logon operation. 

8 If the Node Selection window is displayed, select the outer nodes to which you want to log on (the 
gateway node is already selected) and, if necessary, specify the MIP name, user ID, and password 
required to log on. 

9 Click the OK button to continue the logon operation. Comms Manager attempts to log on to the gateway 
node and then to outer nodes. Comms Manager uses the specified outer node MIP name to establish 
communication with each outer node, and the specified user ID and password to log on. Comms 
Manager displays a message if an error occurs (for example, an invalid user ID and password 
combination). When you have successfully logged on to each node, Comms Manager displays the main 
window. 

Listing Objects 

More Information 
Listing All Objects 
Listing Objects in a Specific State 
Listing Objects With a Specific Name 
Listing Objects in a Specific Subsystem 

Listing All Objects 

To list all objects: 

1 Display the main window. 

2 On the Object menu, point to List, then click All. The Object List window lists all objects.  

Listing Objects in a Specific State 

To list objects in a specific state: 

1 Display the Main window. 

2 On the Object menu, point to List, then a specific state (for example, Started or Not Started). The 
Object List window lists objects. 

Listing Objects With a Specific Name 

To list objects with a specific name: 

1 Display the Main window. 

2 On the Object menu, point to List, then click Specific. 

3 Specify an object name in the List Specific Objects window. 

4 Click OK. The Object List window lists matching objects. 

Listing Objects in a Specific Subsystem 

To list objects in a specific subsystem: 

1 Display the Main window. 

2 On the communications subsystem display, double-click a specific subsystem name (for example, 
SSCP or TELNET). The Object List window lists objects in the subsystem. 

Adding an Object 

To add an object (if you have the authority to do so): 
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1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object above the 
object you want to add. For example, navigate to a TCP/IP process to add a subnet below the process. 

3 Left-click to select the object above the object you want to add, then right-click to display a context-
sensitive pop-up menu. 

4 Point to Add, then click. The appropriate Add window is displayed: 

SNAX/XF Line Add window 
SNAX/XF LU Add/Copy/Modify window 
SNAX/XF PU Add/Copy/Modify window 
TCP/IP Process Add window 
TCP/IP Route Add/Copy window 
TCP/IP Subnet Add/Copy window 
TELNET Process Add window 
TELNET Window Add/Copy/Modify window 
X.25 SU Add/Copy/Modify window 

5 Specify object information. 

6 Click OK. The object is added. 

Copying an Object 

To copy an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
copy. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Copy, then click. The appropriate Copy window is displayed: 

SNAX/XF LU Add/Copy/Modify window 
SNAX/XF PU Add/Copy/Modify window 
TCP/IP Route Add/Copy window 
TCP/IP Subnet Add/Copy window 
TELNET Window Add/Copy/Modify window 
X.25 SU Add/Copy/Modify window 

5 Specify object information. 

6 Click OK. The object is copied. 

Modifying an Object 

To modify an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
modify. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Modify, then click. The appropriate Modify window is displayed: 

Expand Line Modify window 
Expand Path Modify window 
SNAX/XF Line Modify window 
SNAX/XF LU Add/Copy/Modify window 
SNAX/XF PU Add/Copy/Modify window 
SNAX/XF Subsys Modify window 
TCP/IP Process Modify window 
TCP/IP Subnet Modify window 
TELNET Process Modify window 



 

Comms Manager Help The Operations Pack 4.0 Page 40 of 89 

TELNET Window Add/Copy/Modify window 
X.25 SU Add/Copy/Modify window 
X.25.Line Modify window 

5 Specify object information. 

6 Click OK. The object is modified. 

Deleting an Object 

To delete an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
delete. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Delete, then click. A message box is displayed asking you to confirm the deletion. 

5 Confirm the deletion. The object is deleted. 

Starting an Object 

To start an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
start. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Start, if necessary point to a submenu, then click. 

The object is started (if it is not already started). 

Stopping an Object 

To stop an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
stop. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Stop, if necessary point to a submenu, then click. 

The object is stopped (if it is not already stopped). 

Aborting an Object 

To abort an object (if you have the authority to do so): 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object you want to 
abort. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Abort, if necessary point to a submenu, then click. 

The object is aborted (if it is not already aborted). 

Displaying Object Info 

To display object info: 
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1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object about which you 
want to display info. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Info, then click. The appropriate Info window is displayed: 

Expand Line Info window 
Expand Path Info window 
Multilan Line Info window 
SNAX/XF Line Info window 
SNAX/XF LU Info window 
SNAX/XF PU Info window 
SNAX/XF Subsys Info window 
TCP/IP Process Info window 
TCP/IP Route Info window 
TCP/IP Subnet Info window 
TELNET Process Info window 
TELNET Window Info window 
X.25 Line Info window 
X.25 SU Info window 

Displaying Object Status 

To display object status: 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object for which you 
want to display info. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Status, then click. The appropriate Status window is displayed: 

Bisync Line Status window 
Expand Line Status window 
Expand Path Status window 
Multilan Line Status window 
SNAX/XF Line Status window 
SNAX/XF LU Status window 
SNAX/XF PU Status window 
SNAX/XF Subsys Status window 
TCP/IP Process Status window 
TCP/IP Route Status window 
TCP/IP Subnet Status window 
TELNET Process Status window 
TELNET Window Status window 
X.25 Line Status window 
X.25 SU Status window 

Displaying Detailed Object Status 

To display detailed object status: 

1 Display the main window. 

2 Expand the folder hierarchy in the Communications Objects box. Navigate to the object for which you 
want to display detailed info. 

3 Left-click to select the object, then right-click to display a context-sensitive pop-up menu. 

4 Point to Status, then click. The appropriate Status window is displayed: 

5 Click the Details button. The appropriate Status Detail window is displayed: 
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Expand Line Status Detail window 
Expand Path Status Detail window 
TCP/IP Process Status Detail window 
TCP/IP Route Details window 
X.25 Line Status Detail window 
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Managing SLSA/WAN on S-Series 

More Information 
Reference information 
Tasks and tips 
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Reference information 

More Information 
Main window 
Node dialog boxes and displays 
SLSA dialog boxes and displays 
WAN dialog boxes and displays 
Common SLSA/WAN dialog boxes 
System Component Colors 

Main window 

The main window provides access to all Comms Manager SLSA/WAN functions and enables you to 
manage system components (nodes, subsystems, and objects). Colors indicate system component status. 

Menu bar  Provides access to various commands. 
Toolbar  Consists of buttons that provide single-click access to various functions, including 

some menu commands. 
Navigation pane  Displays system components in a hierarchy (left side of the main window). Click to 

select a component. 
Display pane  Displays information about your selection from the navigation pane (right side of the 

main window). 
Status bar  Displays information about the selected system component, and the current date and 

time. 

Menus and commands 

Available menus when Comms Manager SLSA/WAN starts are Session, Object, View, and Help.  

The Object menu is context-sensitive. After Comms Manager SLSA/WAN starts, the menu name and 
available commands depend on the system component that you have selected. 

More Information 
Session menu 
Object menu 
View menu 
Help menu 

Session menu 

Index terms: menu; session; preferences; exit 

The Session menu displays commands for controlling your Comms Manager SLSA/WAN session. 

Preferences Displays the Preferences dialog box. 
Exit Logs you off from all Tandem systems to which you are logged on from Comms Manager 

SLSA/WAN, and exits from Comms Manager SLSA/WAN. 

Object menu 

The Object menu displays commands for working with system components. 

The Object menu is context-sensitive. After Comms Manager SLSA/WAN starts, the menu name and 
available commands depend on the system component that you have selected. 

Tip  After you select a system component, you can also right-click to display the commands. 

More Information 
Node menu 
SLSA menus 
WAN menus 
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Node menu 

The Node menu displays commands for working with nodes. 

Status Displays the Node Status display. 
Save Configuration Displays the Node Save Configuration dialog box. 

SLSA menus 

Use these menus to work with system components in the SLSA subsystem. 

More Information 
SLSA Subsystem menu 
SLSA Adapters menu 
SLSA Adapter menu 
SLSA SAC menu 
SLSA PIF menu 
SLSA LIFs menu 
SLSA LIF menu 
SLSA Monitors menu 
SLSA Monitor menu 

SLSA Subsystem menu 

The SLSA Subsystem menu displays commands for working with the SLSA subsystem. 

Status Detail Displays the SLSA Subsystem Status Detail display. 
Version Displays the Version dialog box. 
Trace Displays the SLSA Trace dialog box. 

SLSA Adapters menu 

The SLSA Adapters menu displays commands for working with SLSA adapters. 

Status Displays the SLSA Adapters Status display.  
Start Displays the Subordinates dialog box. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
Add Adapter Displays the SLSA Adapter Properties (New) dialog box. Use this dialog box when adding 

a new SLSA adapter. 

SLSA Adapter menu 

The SLSA Adapter menu displays commands for working with a specific SLSA adapter. 

Status SACs Displays the SLSA SACs Under Adapter Status display. 
Properties Displays the SLSA Adapter Properties (Existing) dialog box. Use this dialog box when 

displaying the properties of an existing SLSA adapter. 
Start Displays the Subordinates dialog box. 
Reset Resets a SLSA adapter. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
Delete Deletes a SLSA adapter. 

SLSA SAC menu 

The SLSA SAC menu displays commands for working with a SAC. 

Status PIFs Displays the SLSA PIFs Under SAC Status display. 
Properties Displays the SLSA SAC Properties dialog box. Use this dialog box when displaying or 

modifying the properties of an existing SAC. 
Start Displays the Subordinates dialog box. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
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Trace Displays the SLSA Trace dialog box. 

SLSA PIF menu 

Status Detail Displays the SLSA PIF Status Detail display. 
Statistics Displays the SLSA PIF Statistics display. 
Properties Displays the SLSA PIF Properties dialog box. Use this dialog box when displaying or 

modifying the properties of an existing PIF. 
Start Starts a PIF. 
Stop Stops a PIF. 
Abort Aborts a PIF. 
Trace Displays the SLSA Trace dialog box. 

SLSA LIFs menu 

Status Displays the SLSA LIFs Status display. 
Start Starts LIFs. 
Stop Stops LIFs. 
Abort Aborts LIFs. 
Add LIF Displays the SLSA LIF Properties dialog box. Use this dialog box when adding a new LIF. Use 

this dialog box when displaying or modifying the properties of an existing LIF. 

SLSA LIF menu 

Status Detail Displays the SLSA LIF Status Detail display. 
Properties Displays the SLSA LIF Properties dialog box. Use this dialog box when adding a new LIF. 

Use this dialog box when displaying or modifying the properties of an existing LIF. 
Start Starts a LIF. 
Stop Stops a LIF. 
Abort Aborts a LIF. 
Delete Deletes a LIF. 

SLSA Monitors menu 

Status Displays the SLSA Monitors Status display. 
Start Starts LANMON processes. 

SLSA Monitor menu 

Status Detail  Displays the SLSA Monitor Status Detail display. 
Version  Displays the Version dialog box. 
Start  Starts a LANMON process. 
Trace Displays the SLSA Trace dialog box. 

WAN menus 

Use these menus to work with system components in the WAN subsystem. 

More Information 
WAN Subsystem menu 
SWAN Concentrators menu 
SWAN Concentrator menu 
WAN CLIP menu 
SWAN Paths menu 
SWAN Path menu 
SWAN Tasks menu 
SWAN Task menu 
WAN Devices menu 
WAN Device menu 
WAN Processes menu 
WAN Process menu 
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WAN Profiles menu 
WAN Profile menu 

WAN Subsystem menu 

Properties Displays the WAN Subsystem Properties dialog box. Use this dialog box when displaying the 
properties of the WAN manager process ($ZZWAN). 

Primary Displays the WAN Subsystem Primary dialog box. 

SWAN Concentrators menu 

Status Displays the SWAN Concentrators Status display. 
Start Displays the Subordinates dialog box. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
Add SWAN Displays the SWAN Concentrator Properties dialog box. Use this dialog box when adding 

a new SWAN concentrator. Use this dialog box when displaying or modifying the 
properties of an existing SWAN concentrator. 

SWAN Concentrator menu 

Status CLIPs Displays the WAN CLIPs Under SWAN Status display. 
Properties Displays the SWAN Concentrator Properties dialog box. Use this dialog box when adding 

a new SWAN concentrator. Use this dialog box when displaying or modifying the 
properties of an existing SWAN concentrator. 

Start Displays the Subordinates dialog box. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
Add CLIP Displays the Add CLIP dialog box. Use this dialog box when adding a new CLIP. 
Delete Deletes a SWAN Concentrator. 

WAN CLIP menu 

Version Displays the Version dialog box. 
Start Displays the Subordinates dialog box. 
Stop Displays the Subordinates dialog box. 
Abort Displays the Subordinates dialog box. 
Delete Deletes a WAN CLIP. 

SWAN Paths menu 

Status Displays the SWAN Paths Status display. 
Add Path Displays the SWAN Path Properties dialog box. Use this dialog box when adding a new path. 

Use this dialog box when displaying or modifying the properties of an existing path. 

SWAN Path menu 

Properties Displays the SWAN Path Properties dialog box. Use this dialog box when adding a new path. 
Use this dialog box when displaying or modifying the properties of an existing path. 

Start Starts a path. 
Stop Stops a path. 
Abort Aborts a path. 
Delete Deletes a path. 

SWAN Tasks menu 

Status Displays the SWAN Tasks Status display. 

SWAN Task menu 

Properties Displays the SWAN Task Properties dialog box. Use this dialog box when displaying or 
modifying the properties of an existing task. 
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Start Starts a task. 
Stop Stops a task. 
Abort Aborts a task. 

WAN Devices menu 

Status Displays the WAN Devices Status display. 
Start Starts devices. 
Stop Stops devices. 
Add Device Displays the WAN Device Properties dialog box. Use this dialog box when adding a new 

device. Use this dialog box when displaying or modifying the properties of an existing 
device. 

WAN Device menu 

Properties Displays the WAN Device Properties dialog box. Use this dialog box when adding a new 
device. Use this dialog box when displaying or modifying the properties of an existing 
device. 

Start Starts a device. 
Stop Stops a device. 
Delete Deletes a device. 

WAN Processes menu 

Status Displays the WAN Processes Status display. 
Start Starts processes. 
Stop Stops processes. 
Abort Aborts processes. 
Add Process Displays the WAN Process Properties dialog box. Use this dialog box when adding a new 

device. Use this dialog box when displaying or modifying the properties of an existing 
device. 

WAN Process menu 

Properties Displays the WAN Process Properties dialog box. Use this dialog box when adding a new 
device. Use this dialog box when displaying or modifying the properties of an existing 
device. 

Version Displays the Version dialog box. 
Start Starts a process. 
Stop Stops a process. 
Abort Aborts a process. 
Delete Deletes a process. 

WAN Profiles menu 

Status Displays the WAN Profiles Status display. 
Add Profile Displays the WAN Profile Properties (New) dialog box. Use this dialog box when adding a 

new profile. 

WAN Profile menu 

Properties Displays the WAN Profile Properties (Existing) dialog box. Use this dialog box when 
displaying an existing profile. 

Delete Deletes a profile. 

View menu 

The View menu displays commands for controlling the appearance of the main window. 

Toolbar  Specifies whether to show or hide the toolbar, and sets the size of the toolbar buttons. 
Status Bar Specifies whether to show or hide the status bar. 
Large Icons Displays system components as large icons (arranged left to right across the window). 
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Small Icons Displays system components as small icons (arranged left to right across the window). 
List Displays system components as small icons in a list (arranged top to bottom down the 

window). 
Details Displays detailed information about the selected system component. 
Refresh Refreshes the current display. 

Help menu 

The Help menu has the following commands for getting help: 

Contents Starts Help and displays the first topic. 
Search For Help On Starts Help and displays the Index. 
What's This? Displays the What's This cursor. 
About Displays contact and version information. 

Preferences dialog box 

Index terms: dialog; preferences 

The Preferences dialog box modifies preferences for Comms Manager SLSA/WAN. 

Host Timeout 

Host Timeout specifies the time (1 through 32,767 seconds) that Comms Manager SLSA/WAN waits for a 
response from the Tandem host after making a request. The default is 30 seconds. 

SCF Server 

SCF Server configures the server process on the Tandem host that handles SCF requests. 

Program File Specifies the file name. The default name is $SYSTEM.SYSTEM.SCF. 
CPU  Specifies a number from 0 through 15, or a blank to specify the same CPU as the MIP. 
Priority  Specifies a number from 1 through 199, or a blank to specify the same priority as the MIP. 

Node dialog boxes and displays 

Use these dialog boxes to work with nodes. 

More Information 
Node Status display 
Node Save Configuration dialog box 

Node Status display 

The Node Status display summarizes the status of system components in the SLSA and WAN subsystems. 

Double-click the name of a system component type (Adapters, SWANs, and so on) to display the status of 
all components of that type. 

Right-click in a bar to display a context-sensitive pop-up menu. Double-click in a colored bar to display the 
status of all components in a certain state. 

Node Save Configuration dialog box 

The Node Save Configuration dialog box displays previous configuration versions and saves the current 
configuration. 

Previous Configuration Versions Lists previous configuration versions. 
Save Configuration as Version Specifies the version number to identify major and minor version 

changes. 

Note  For more information, refer to the SCF SAVE CONFIGURATION command in the LAN Configuration and 
Management Manual. 

SLSA dialog boxes and displays 

Use these dialog boxes to work with SLSA system components. 
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More Information 
SLSA Subsystem dialog boxes and displays 
SLSA Adapter dialog boxes and displays 
SLSA SAC dialog boxes and displays 
SLSA PIF dialog boxes and displays 
SLSA LIF dialog boxes and displays 
SLSA Monitor dialog boxes and displays 
Common SLSA dialog boxes 

SLSA Subsystem dialog boxes and displays 

Use these dialog boxes to work with the SLSA subsystem LANMAN process ($ZZLAN). 

More Information 
SLSA Subsystem Status Detail display 

SLSA Subsystem Status Detail display 

The SLSA Subsystem Status Detail display summarizes the detailed status of the LANMAN process 
($ZZLAN). 

Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

More Information 
Process State 
Resources 
Trace 
Heap Memory 
QIO Pool 

Process State 

Process State displays the state of the LANMAN process ($ZZLAN). 

Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

Resources 

Resources displays the PID (CPU and process ID) of the primary and Backup process and the process 
Priority. 

Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

Trace 

Trace specifies trace Status (whether tracing is enabled) and, if so, the trace Filename. 

Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

Heap Memory 

Heap Memory displays the amount of heap memory Used and the heap memory Limit. 

Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

QIO Pool 

QIO Pool displays the Current QIO pool size and the QIO pool Limit. 
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Note  For more information, refer to the SCF STATUS PROCESS command in the LAN Configuration and 
Management Manual. 

SLSA Adapter dialog boxes and displays 

Use these dialog boxes and displays to work with SLSA adapters. 

More Information 
SLSA Adapters Status display 
SLSA Adapter Properties (New) dialog box 
SLSA Adapter Properties (Existing) dialog box 

SLSA Adapters Status display 

The SLSA Adapters Status display summarizes the status of SLSA adapters. 

Adapter Specifies the name. 
State Specifies the state. 
SP Cru Presence Status Specifies service processor presence information. 
SP Cru Test Status Specifies service processor test information. 

Click to select an adapter, then right-click to display menu commands. Double-click to display the status of 
all SACs under the adapter (SLSA SACs Under Adapter Status display). 

Note  For more information, refer to the SCF STATUS ADAPTER command in the LAN Configuration and 
Management Manual. 

SLSA Adapter Properties (New) dialog box 

The SLSA Adapter Properties dialog box specifies the properties of a new SLSA adapter. Use this dialog 
box when adding a new SLSA adapter. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

More Information 
SLSA Adapter Properties (New) General tab 
SLSA Adapter Properties (New) SAC tab 

SLSA Adapter Properties (New) General tab 

The SLSA Adapter Properties General tab specifies the general properties of a new SLSA adapter. Use 
this tab when adding a new SLSA adapter. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

More Information 
Type 
Location 
Adapter Name 

Type 

Type specifies the type of SLSA adapter. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Location 

Location specifies the adapter location. 

Group Corresponds to the cabinet number. 
Slot Specifies the slot number. 
Module Specifies the module (the value is always 1 on S-series systems). 
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Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Adapter Name 

Adapter Name specifies the adapter name. Standard specifies a name that is created from the Type, 
Group, and Slot values (this conforms to the Tandem Manufacturing Naming Conventions). Custom 
specifies a name that you type. 

Note  For more information, refer to the SCF ADD ADAPTER command and the Tandem Manufacturing 
Naming Conventions in the LAN Configuration and Management Manual. 

SLSA Adapter Properties (New) SAC tab 

The SLSA Adapter Properties SAC tab specifies the SAC properties of a new SLSA adapter. Use this tab 
when adding a new SLSA adapter. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

More Information 
Access List 
Auto Start 
Download Filename 
Firmware Filename 
Dump Filename 

Access List 

Access List specifies the CPUs that are allowed to access the SAC. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Auto Start 

Auto Start specifies whether the SAC and subordinate PIFs automatically start during a cold start. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Download Filename 

Download Filename specifies the name of the file with the application microcode that is downloaded to the 
subordinate SACs when they are started. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Firmware Filename 

Firmware Filename specifies the name of the file with the firmware microcode that is downloaded to the 
SAC. Select Auto Firmware Update to download the firmware before the operation code. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 

Dump Filename 

Dump Filename specifies the name of the file that stores adapter dump information if a SAC fails. You 
should generally specify 00 as the last two characters of the file name. Select Auto Dump to automatically 
dump information if a SAC fails. 

Note  For more information, refer to the SCF ADD ADAPTER command in the LAN Configuration and 
Management Manual. 
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SLSA Adapter Properties (Existing) dialog box 

The SLSA Adapter Properties (Existing) dialog box specifies the properties of an existing SLSA adapter. 
Use this dialog box when displaying the properties of an existing SLSA adapter. You cannot modify the 
properties of an existing SLSA adapter. 

Note  For more information, refer to the SCF INFO ADAPTER command in the LAN Configuration and 
Management Manual. 

More Information 
Adapter Type 
Location 
Board 

Adapter Type 

Adapter Type displays the adapter type. 

Note  For more information, refer to the SCF INFO ADAPTER command in the LAN Configuration and 
Management Manual. 

Location 

Location displays the group, module, and slot of the adapter. 

Note  For more information, refer to the SCF INFO ADAPTER command in the LAN Configuration and 
Management Manual. 

Board 

Board displays the part number, serial number, revision level, and Tandem product number of the adapter. 

Note  For more information, refer to the SCF INFO ADAPTER command in the LAN Configuration and 
Management Manual. 

SLSA SAC dialog boxes and displays 

Use these dialog boxes and displays to work with SLSA SACs. 

More Information 
SLSA SACs Under Adapter Status display 
SLSA SAC Properties dialog box 

SLSA SACs Under Adapter Status display 

The SLSA SAC Under Adapter Status display summarizes the status of SACs subordinate to a SLSA 
adapter. 

SAC  Specifies the SAC name. 
Owner  Specifies the CPU that owns the SAC. 
State  Specifies the state. 
Last Error  Specifies the last error (severity, origin, error code). (0,0,0) specifies no errors. 
Current Access  Specifies the CPUs that have access to the SAC. NONE specifies no CPUs. 
Last Download  Specifies when application microcode was last downloaded to the adapter. 
Trace Status  Specifies whether the SAC is being traced. 
Trace Filename  Specifies the trace file name, if the SAC is being traced. 

Click to select a SAC, then right-click to display menu commands. Double-click to display the status of all 
PIFs under the SAC (SLSA PIFs Under SAC Status display). 

Note  For more information, refer to the SCF STATUS SAC command in the LAN Configuration and 
Management Manual. 
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SLSA SAC Properties dialog box 

The SLSA SAC Properties dialog box specifies the properties of a SAC. Use this dialog box when 
displaying or modifying the properties of an existing SAC. You cannot explicitly add a new SAC; SACs are 
created when you add an adapter. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

More Information 
SLSA SAC Properties General tab 
SLSA SAC Properties Firmware tab 

SLSA SAC Properties General tab 

The SLSA SAC Properties General tab specifies the general properties of a SAC. Use this tab when 
displaying or modifying the properties of an existing SAC. You cannot explicitly add a new SAC; SACs are 
created when you add an adapter. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

More Information 
SAC Type 
Owner CPU 
Access List 
SvNet ID 
Auto Start 
Auto Dump 
Dump Filename 

SAC Type 

SAC Type specifies the type of SAC. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Owner CPU 

Owner CPU specifies the CPU that owns the SAC. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Access List 

Access List specifies the CPUs that are allowed to access the SAC. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

SvNet ID 

SvNet ID specifies the SAC ServerNet ID. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Auto Start 

Auto Start specifies whether the SAC and subordinate PIFs automatically start during a cold start. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 
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Auto Dump 

Auto Dump specifies whether the SAC automatically dumps information if the SAC fails. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Dump Filename 

Dump Filename specifies the name of the file that stores adapter dump information if the SAC fails. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

SLSA SAC Properties Firmware tab 

The SLSA SAC Properties Firmware tab specifies SAC firmware information. Use this tab when 
displaying or modifying the properties of an existing SAC. You cannot explicitly add a new SAC; SACs are 
created when you add an adapter. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

More Information 
Auto Reload 
Auto FirmUp 
Download Filename 
Firmware Filename 
Download Version 
Firmware Revision 
Firmware File Rev 

Auto Reload 

Auto Reload specifies whether to automatically reload application microcode to the SAC if the SAC fails. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Auto FirmUp 

Auto FirmUp specifies whether to automatically replace the current adapter firmware file if a more recent 
version exists. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Download Filename 

Download Filename specifies the name of the file with the application microcode that is downloaded to the 
SAC when it is started. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Firmware Filename 

Firmware Filename specifies the name of the file with the firmware microcode that is downloaded to the 
SAC when it is started. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 
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Download Version 

Download Version specifies the application microcode version. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Firmware Revision 

Firmware Revision specifies the firmware version. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

Firmware File Rev 

Firmware File Rev specifies firmware revision level. 

Note  For more information, refer to the SCF ALTER SAC and SCF INFO SAC commands in the LAN 
Configuration and Management Manual. 

SLSA PIF dialog boxes and displays 

Use these dialog boxes and displays to work with SLSA PIFs. 

More Information 
SLSA PIFs Under SAC Status display 
SLSA PIF Status Detail display 
SLSA PIF Statistics display 
SLSA PIF Properties dialog box 

SLSA PIFs Under SAC Status display 

The SLSA PIFs Under SAC Status display summarizes the status of PIFs subordinate to a SAC. 

PIF Specifies the PIF name. 
State Specifies the state. 
Trace Status Specifies whether the PIF is being traced. 

Click to select a PIF, then right-click to display menu commands. Double-click to display the detailed status 
of a PIF (SLSA PIF Status Detail display). 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

SLSA PIF Status Detail display 

The SLSA PIF Status Detail display summarizes the detailed status of a PIF. 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

More Information 
PIF State 
CPUs with Data Path 
Trace 
E4SA Adapter Status 
TRSA Adapter Status 

PIF State 

PIF State displays the PIF state. Last Error specifies the last error (severity, origin, error code). (0,0,0) 
indicates no errors. Interface Status displays the PIF interface status. 
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Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

CPUs with Data Path 

CPUs with Data Path displays CPUs with a data path to the PIF. 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

Trace 

Trace displays whether tracing is enabled and, if so, the name of the trace file. 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

E4SA Adapter Status 

E4SA Adapter Status displays the status of a PIF on an Ethernet 4 ServerNet Adapter (E4SA). Link Pulse 
State displays the Ethernet link pulse state. 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

TRSA Adapter Status 

TRSA Adapter Status displays the status of a PIF on a Token Ring ServerNet adapter (TRSA). Ring State 
displays the token ring state. Ring Open State displays the result of the adapter's last attempt to enter the 
token ring. Last Ring Status is the token ring interface status. 

Note  For more information, refer to the SCF STATUS PIF command in the LAN Configuration and 
Management Manual. 

SLSA PIF Statistics display 

The SLSA PIF Statistics display shows statistics for the PIF. 

Note  For more information, refer to the SCF STATS PIF command in the LAN Configuration and 
Management Manual. 

SLSA PIF Properties dialog box 

The SLSA PIF Properties dialog box specifies the properties of a PIF. Use this dialog box when displaying 
or modifying the properties of an existing PIF. You cannot explicitly add a PIF; PIFs are created when you 
add an adapter. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

More Information 
SLSA PIF Properties General tab 
SLSA PIF Properties TRSA Specific tab 

SLSA PIF Properties General tab 

The SLSA PIF Properties General tab specifies the general properties of a PIF. Use this tab when 
displaying or modifying the properties of an existing PIF. You cannot explicitly add a PIF; PIFs are created 
when you add an adapter. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

More Information 
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PIF Type 
Interface Speed 
Min Frame Size 
Max Frame Size 
H'ware MAC Address 
Node MAC Address 

PIF Type 

PIF Type specifies the network interface type. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Interface Speed 

Interface Speed specifies the maximum network interface speed. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Min Frame Size 

Min Frame Size specifies the minimum frame size for the adapter. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Max Frame Size 

Max Frame Size specifies the maximum frame size for the adapter. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

H'ware MAC Address 

H'ware MAC Address specifies the media access control (MAC) address. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Node MAC Address 

Node MAC Address specifies the primary media access control (MAC) used when transmitting and 
receiving frames. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

SLSA PIF Properties TRSA Specific tab 

The SLSA PIF Properties TRSA Specific tab specifies the Token-Ring ServerNet adapter (TRSA)-specific 
properties of a PIF. Use this tab when displaying or modifying the properties of an existing PIF. You 
cannot explicitly add a PIF; PIFs are created when you add an adapter. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

More Information 
Ring Speed 
Max Sessions 
Active Monitor 
Early Token Release 
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Ring Speed 

Ring Speed specifies the token-ring speed (4 or 16 Mbps). 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Max Sessions 

Max Sessions specifies the maximum number of sessions for the token-ring. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Active Monitor 

Active Monitor specifies whether the adapter monitors the token-ring. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

Early Token Release 

Early Token Release specifies whether the adapter uses Early Token Release mode. 

Note  For more information, refer to the SCF ALTER PIF and SCF INFO PIF commands in the LAN 
Configuration and Management Manual. 

SLSA LIF dialog boxes and displays 

Use these dialog boxes and displays to work with SLSA LIFs. 

More Information 
SLSA LIFs Status display 
SLSA LIF Status Detail display 
SLSA LIF Properties dialog box 

SLSA LIFs Status display 

The SLSA LIFs Status display summarizes the status of LIFs. 

LIF Specifies the name. 
State Specifies the state. 
Access State Specifies whether a LIF can access the PIF. 

Click to select a LIF, then right-click to display menu commands. Double-click to display the detailed status 
of the LIF (SLSA LIF Status Detail display). 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

SLSA LIF Status Detail display 

The SLSA LIF Status Detail display summarizes the detailed status of a LIF. 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

More Information 
LIF State 
CPUs with Data Path 
Potential Access CPUs 
Trace 
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LIF State 

LIF State specifies the LIF state. Access State specifies whether at least one CPU has a data path through 
the PIF associated with the LIF. 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

CPUs with Data Path 

CPUs with Data Path specifies CPUs with a data path through the PIF associated with the LIF. 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

Potential Access CPUs 

Potential Access CPUs specifies CPUs with a potential data path through the PIF associated with the LIF. 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

Trace 

Trace specifies whether tracing is enabled and, if so, the name of the trace file. 

Note  For more information, refer to the SCF STATUS LIF command in the LAN Configuration and 
Management Manual. 

SLSA LIF Properties dialog box 

The SLSA LIF Properties dialog box specifies the properties of a LIF. Use this dialog box when adding a 
new LIF. Use this dialog box when displaying or modifying the properties of an existing LIF. 

Note  For more information, refer to the SCF ADD LIF, SCF ALTER LIF , and SCF INFO LIF  commands in 
the LAN Configuration and Management Manual. 

More Information 
Associated PIF 
LIF Name 
Data Forward 
Type 

Associated PIF 

Associated PIF specifies the Name of the PIF associated with the LIF. MAC specifies the media access 
control (MAC) address of the LIF. 

Note  For more information, refer to the SCF ADD LIF, SCF ALTER LIF , and SCF INFO LIF  commands in 
the LAN Configuration and Management Manual. 

LIF Name 

LIF Name specifies the LIF name. Standard specifies a name that is created from the group number and 
port ID ($ZZLAN.Lnnn) (this conforms to the Tandem Manufacturing Naming Conventions). Custom 
specifies a name that you type. 

Note  For more information, refer to the SCF ADD LIF, SCF ALTER LIF , and SCF INFO LIF  commands 
and the Tandem Manufacturing Naming Conventions in the LAN Configuration and Management Manual. 
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Data Forward 

Data Forward specifies information about inbound frames. Count specifies the maximum number of 
inbound frames queued before delivery. Time specifies the maximum time (in milliseconds) an inbound 
frame waits before delivery. 

Note  For more information, refer to the SCF ADD LIF, SCF ALTER LIF , and SCF INFO LIF  commands in 
the LAN Configuration and Management Manual. 

Type 

Type specifies the network interface type. 

Note  For more information, refer to the SCF ADD LIF, SCF ALTER LIF , and SCF INFO LIF  commands in 
the LAN Configuration and Management Manual. 

SLSA Monitor dialog boxes and displays 

Use these dialog boxes and displays to work with SLSA LANMON processes. 

More Information 
SLSA Monitors Status display 
SLSA Monitor Status Detail display 

SLSA Monitors Status display 

The SLSA Monitors Status display summarizes the status of LANMON processes. 

Monitor Specifies the name. 
State Specifies the state. 
PID Specifies the CPU and process ID. 
Priority Specifies the priority. 
Trace Status Specifies whether the LANMON process is being traced. 

Click to select a LANMON process, then right-click to display menu commands. Double-click to display the 
detailed status of the LANMON process (SLSA Monitor Status Detail display). 

Note  For more information, refer to the SCF STATUS MON command in the LAN Configuration and 
Management Manual. 

SLSA Monitor Status Detail display 

The SLSA Monitor Status Detail display summarizes the detailed status of a LANMON process. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

More Information 
Monitor State 
Resources 
Trace 
Heap Memory 
QIO Pool 
Monitor Info 

Monitor State 

Monitor State specifies the state of the LANMON process. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

Resources 

Resources specifies the PID (CPU and process ID) and Priority of the LANMON process. 
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Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

Trace 

Trace specifies trace Status (whether tracing is enabled) and, if so, the trace Filename. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

Heap Memory 

Heap Memory displays the amount of heap memory Used and the heap memory Limit. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

QIO Pool 

QIO Pool displays the Current QIO pool size and the QIO pool Limit. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

Monitor Info 

Monitor Info displays whether SaveAbend information is saved if the LANMON process fails and the 
LANMON process Program Name. 

Note  For more information, refer to the SCF INFO MON and SCF STATUS MON commands in the LAN 
Configuration and Management Manual. 

Common SLSA dialog boxes 

These dialog boxes are used by more than one object in the SLSA subsystem. 

More Information 
SLSA Trace dialog box 

SLSA Trace dialog box 

Starts, stops, or modifies the trace of the LANMAN process ($ZZLAN), SACs, PIFs, or monitor processes in 
the SLSA subsystem. 

Note  For more information, refer to the SCF TRACE command in the LAN Configuration and Management 
Manual. 

More Information 
Trace Operation 
File Information 
Trace Option 
Memory 

Trace Operation 

Specifies whether to start, stop, or modify a trace. 

File Information 

File Information specifies the properties of a trace file. 

Trace File Specifies the file that records trace information. 
Rec Size Specifies the data record length (16 through 4050; default is 120). 
Count Specifies the number of captured records (0 through 32767; default is blank, which means no 

limit). 
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Bulk I/O Specifies whether to use bulk I/O tracing. 
No Coll If selected, trace records are written only when the trace is stopped or the number of trace 

records equals the value of Count; otherwise records are written continuously. 
Wrap If selected, when the trace file is full, new trace records overwrite old records starting from the 

beginning of the file; otherwise tracing stops. 

Note  For more information, refer to the SCF TRACE command in the LAN Configuration and Management 
Manual. 

Trace Option 

Select specifies either a keyword or a number that defines the type of tracing that is performed. 

Note  For more information, refer to the SCF TRACE command in the LAN Configuration and Management 
Manual. 

Memory 

Memory specifies memory resources. 

Pages Specifies the space used for tracing in the extended data segment (4 through 1024; default is 
64). 

Locksize Specifies how many Pages are locked at any time (4 through 1024). 

Note  For more information, refer to the SCF TRACE command in the LAN Configuration and Management 
Manual. 

WAN dialog boxes and displays 

Use these dialog boxes to work with WAN system components. 

More Information 
WAN Subsystem dialog boxes and displays 
SWAN Concentrator dialog boxes and displays 
WAN CLIP dialog boxes and displays 
SWAN Path dialog boxes and displays 
SWAN Task dialog boxes and displays 
WAN Devices dialog boxes and displays 
WAN Process dialog boxes and displays 
WAN Profile dialog boxes and displays 

WAN Subsystem dialog boxes and displays 

Use these dialog boxes to work with the WAN manager process ($ZZWAN). 

More Information 
Objects Under WAN Subsystem display 
WAN Subsystem Properties dialog box 
WAN Subsystem Primary dialog box 

Objects Under WAN Subsystem display 

The Objects Under WAN Subsystem display shows the types of objects (SWAN concentrators, WAN 
devices, WAN processes, and WAN profiles) under the WAN manager process ($ZZWAN). 

Click to select an object type, then right-click to display menu commands. Double-click to display the status 
of all objects of that type (SWAN Concentrators Status display, WAN Devices Status display, WAN 
Processes Status display, WAN Profiles Status display). 

Note  For more information, refer to the WAN Subsystem Configuration and Management Manual. 

WAN Subsystem Properties dialog box 

The WAN Subsystem Properties dialog box specifies the properties of the WAN manager process 
($ZZWAN). Use this dialog box when displaying the properties of the WAN manager process ($ZZWAN). 
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Note  For more information, refer to the SCF INFO SUBSYS command in the WAN Subsystem Configuration 
and Management Manual. 

More Information 
Config File 
IOP Object 

Config File 

Config File specifies the WAN manager process ($ZZWAN) configuration file name. 

Note  For more information, refer to the SCF INFO SUBSYS command in the WAN Subsystem Configuration 
and Management Manual. 

IOP Object 

IOP Object specifies the name of the program object file for the WAN manager process ($ZZWAN). 

Note  For more information, refer to the SCF INFO SUBSYS command in the WAN Subsystem Configuration 
and Management Manual. 

WAN Subsystem Primary dialog box 

The WAN Subsystem Primary dialog box specifies the CPU Number for the Primary WAN manager 
process ($ZZWAN). 

Note  For more information, refer to the SCF PRIMARY SUBSYS command in the WAN Subsystem 
Configuration and Management Manual. 

SWAN Concentrator dialog boxes and displays 

Use these dialog boxes to work with SWAN concentrators. 

More Information 
SWAN Concentrators Status display 
SWAN Concentrator Properties dialog box 
WAN CLIPs Under SWAN Status display 
Add CLIP dialog box 

SWAN Concentrators Status display 

The SWAN Concentrators Status display summarizes the status of SWAN concentrators. 

Adapter Specifies the name. 
State Specifies the state. 
CLIPs Specifies the number of CLIPs configured for the SWAN concentrator. 
CLIP n Status Specifies the configuration status of each CLIP. 

Click to select a SWAN concentrator, then right-click to display menu commands. Double-click to display the 
status of all WAN CLIPs under the SWAN concentrator (WAN CLIPs Under SWAN Status display). 

Note  For more information, refer to the SCF STATUS ADAPTER command in the WAN Subsystem 
Configuration and Management Manual. 

SWAN Concentrator Properties dialog box 

The SWAN Concentrator Properties dialog box specifies the properties of a SWAN concentrator. Use this 
dialog box when adding a new SWAN concentrator. Use this dialog box when displaying or modifying the 
properties of an existing SWAN concentrator. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
Name 
Concentrator Type 
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Preferred TCP/IP Transport 
Alternate TCP/IP Transport 
Path A 
Path B 
Track ID 
Code Files 

Name 

Name specifies the SWAN concentrator name (this should conform to the Tandem Manufacturing Naming 
Conventions). 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands and the Tandem Manufacturing Naming Conventions in the WAN Subsystem Configuration and 
Management Manual. 

Concentrator Type 

Concentrator Type specifies the SWAN concentrator type. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Preferred TCP/IP Transport 

Preferred TCP/IP Transport specifies information about the preferred TCP/IP process for the SWAN 
concentrator. TCP/IP Name specifies the process name. Host IP Address specifies the subnet TCP/IP 
address. Subnet Mask specifies the subnet's subnet mask. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Alternate TCP/IP Transport 

Alternate TCP/IP Transport specifies information about the alternate TCP/IP process for the SWAN 
concentrator. TCP/IP Name specifies the process name. Host IP Address specifies the subnet TCP/IP 
address. Subnet Mask specifies the subnet's subnet mask. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Path A 

Path A specifies the Gateway Address (IP address) for the SWAN concentrator. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Path B 

Path B specifies the alternate Gateway Address (IP address) for the SWAN concentrator. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Track ID 

Track ID specifies the unique identifier for the SWAN concentrator. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 
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Code Files 

Code Files specifies information about code files. Kernel Code specifies the firmware microcode filename. 
SNMP Code specifies program object file name for the SNMP agent process. 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

WAN CLIPs Under SWAN Status display 

The WAN CLIPs Under SWAN Status display summarizes the status of WAN CLIPs subordinate to a 
SWAN concentrator. 

CLIP Specifies the number. 
State Specifies the state. 
Path A Specifies whether Path A is configured. 
Path B Specifies whether Path B is configured. 
Lines Specifies the number of available WAN lines on the CLIP. 
Line n Specifies the name of the device configured to use the WAN line, or FREE if no device is 

configured. 

Click to select a WAN CLIP, then right-click to display menu commands. Double-click to display objects 
under the WAN CLIP (Objects Under WAN CLIP display). 

Note  For more information, refer to the SCF ADD ADAPTER, SCF ALTER ADAPTER, and SCF INFO ADAPTER 
commands in the WAN Subsystem Configuration and Management Manual. 

Add CLIP dialog box 

The Add CLIP dialog box adds a New CLIP to a SWAN concentrator. Use this dialog box when adding a 
new CLIP. 

Note  For more information, refer to the SCF ADD SERVER command in the WAN Subsystem Configuration 
and Management Manual. 

WAN CLIP dialog boxes and displays 

Use these dialog boxes to work with WAN CLIPs. 

More Information 
Objects Under WAN CLIP display 

Objects Under WAN CLIP display 

The Objects Under WAN CLIP display shows the types of objects (SWAN ethernet paths and SWAN Data 
Link Control tasks) under a WAN CLIP. 

Click to select an object type, then right-click to display menu commands. Double-click to display the status 
of all objects of that type (SWAN Paths Status display, SWAN Tasks Status display). 

Note  For more information, refer to the WAN Subsystem Configuration and Management Manual. 

SWAN Path dialog boxes and displays 

Use these dialog boxes to work with SWAN paths. 

More Information 
SWAN Paths Status display 
SWAN Path Properties dialog box 

SWAN Paths Status display 

The SWAN Paths Status display summarizes the status of SWAN paths. 

Path Specifies the name. 
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State Specifies the state. 
Media Type Specifies the media type. 
Media Address Specifies the media access control (MAC) address. 

Click to select a SWAN path, then right-click to display menu commands. 

Note  For more information, refer to the SCF STATUS PATH command in the WAN Subsystem Configuration 
and Management Manual. 

SWAN Path Properties dialog box 

The SWAN Path Properties dialog box specifies the properties of a SWAN path. Use this dialog box when 
adding a new path. Use this dialog box when displaying or modifying the properties of an existing path. 

Note  For more information, refer to the SCF ADD PATH, SCF ALTER PATH, and SCF INFO PATH commands in 
the WAN Subsystem Configuration and Management Manual. 

More Information 
Name 
IP Address 

Name 

Name specifies the name of the Ethernet Path (A or B). 

Note  For more information, refer to the SCF ADD PATH, SCF ALTER PATH, and SCF INFO PATH commands in 
the WAN Subsystem Configuration and Management Manual. 

IP Address 

IP Address specifies the IP address of the Ethernet path. 

Note  For more information, refer to the SCF ADD PATH, SCF ALTER PATH, and SCF INFO PATH commands in 
the WAN Subsystem Configuration and Management Manual. 

SWAN Task dialog boxes and displays 

Use these dialog boxes to work with SWAN tasks. 

More Information 
SWAN Tasks Status display 
SWAN Task Properties dialog box 

SWAN Tasks Status display 

The SWAN Tasks Status display summarizes the status of SWAN tasks. If you have selected a task in the 
navigation pane, the task is highlighted in the display pane. 

Task Specifies the name. 
State Specifies the state. 
Path Specifies the CLIP path name that the task uses to communicate with the 

input/output process. 
Protocol ID Specifies the protocol ID. 
TCP/IP Port Specifies the TCP/IP that the task uses to communicate with the input/output 

process. 
Interface Type Specifies the interface type. 
CLIP Program Specifies the CLIP program file name used to create the task. 
Program Timestamp Specifies the timestamp for the CLIP program file. 

Click to select a task, then right-click to display menu commands. 

Note  For more information, refer to the SCF STATUS TASK command in the WAN Subsystem Configuration 
and Management Manual. 
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SWAN Task Properties dialog box 

The SWAN Task Properties dialog box specifies the properties of a SWAN task. Use this dialog box when 
displaying or modifying the properties of an existing task. 

Note  For more information, refer to the SCF ALTER TASK and SCF INFO TASK commands in the WAN 
Subsystem Configuration and Management Manual. 

More Information 
Program 
Preferred Path 
IP Port Number 

Program 

Program specifies the Microcode Object File name that is downloaded for the task. 

Note  For more information, refer to the SCF ALTER TASK and SCF INFO TASK commands in the WAN 
Subsystem Configuration and Management Manual. 

Preferred Path 

Preferred Path specifies the preferred path for the task. 

Note  For more information, refer to the SCF ALTER TASK and SCF INFO TASK commands in the WAN 
Subsystem Configuration and Management Manual. 

IP Port Number 

IP Port Number specifies the IP port number for the task. 

Note  For more information, refer to the SCF ALTER TASK and SCF INFO TASK commands in the WAN 
Subsystem Configuration and Management Manual. 

WAN Devices dialog boxes and displays 

Use these dialog boxes to work with WAN devices. 

More Information 
WAN Devices Status display 
WAN Device Properties dialog box 
Select WAN Device Type dialog box 

WAN Devices Status display 

The WAN Devices Status display summarizes the status of WAN devices. If you have selected a device in 
the navigation pane, the device is highlighted in the display pane. 

Device Specifies the name. 
State Specifies the state. 
LDev Specifies the logical device (LDev) number. 
Primary PIN Specifies the primary PIN. 
Backup PIN Specifies the backup PIN. 

Click to select a WAN device, then right-click to display menu commands. 

Note  For more information, refer to the SCF STATUS DEVICE command in the WAN Subsystem 
Configuration and Management Manual. 

WAN Device Properties dialog box 

The WAN Device Properties dialog box specifies the properties of a WAN device. Use this dialog box when 
adding a new device. Use this dialog box when displaying or modifying the properties of an existing 
device. 
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Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
WAN Device Properties General tab 
WAN Device Properties Profile and Modifiers tab 
WAN Device Properties Modifiers tab 

WAN Device Properties General tab 

The WAN Device Properties General tab specifies the general properties of a WAN device. Use this tab 
when adding a new device. Use this tab when displaying or modifying the properties of an existing device. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
Name 
SWAN Adapter 
CPUs 
High PIN 
Type 
Multi-Line Path Name 

Name 

Name specifies the device name. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

SWAN Adapter 

SWAN Adapter specifies information about the SWAN adapter used by the device. Name specifies the 
SWAN adapter name. CLIP specifies the CLIP used by the device. Path specifies the SWAN concentrator 
ethernet path (A or B) used by the device. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

CPUs 

CPUs specifies the CPU number for the Preferred (primary) and Alternate (backup) processes.. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

High PIN 

High PIN specifies whether the device is to run highpin. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

Type 

Type specifies information about the device type. 

For a new device, click Select Type to select the communications subsystem and object type for a device by 
using the Select WAN Device Type dialog box. This completes other fields automatically with default values. 

Description describes the communications subsystem and object type for a device. IOP Object specifies 
the program object file for the subsystem and object type. Device Type specifies the device and subtype. 
Record Size specifies the record size supported for the device type. 
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For a new device, Profile Type specifies the default profile for the device type. Click Add Profile to add a 
Profile Type by using the WAN Profile Properties (New) dialog box. For an existing device, Profile Name 
specifies the name of the profile configured for the device when the device was added. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

Multi-Line Path Name 

Multi-Line Path Name specifies the path name. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

WAN Device Properties Profile and Modifiers tab 

The WAN Device Properties Profile and Modifiers tab specifies the profile and modifier properties of a 
WAN device. Use this tab when adding a new device. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
Use Profile 
Override Modifiers 

Use Profile 

Use Profile specifies the profile for the new device. 

Click From Profile Object to type an existing profile name or select from a list of existing profiles. After 
selecting a profile, optionally click Show Profile to display information about the profile in the WAN Profile 
Properties (Existing) dialog box. 

Click From Existing Device to type an existing device name or select an existing device, and to use the 
same profile as that device. After selecting a device, optionally click Show Device to display information 
about the device in the WAN Device Properties dialog box. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

Override Modifiers 

Override Modifiers overrides the default value for modifiers. To override the default value, do one of the 
following: 

• Type the Modifier name and new Value, then click Add. 

• Click either Show Profile or Show Device, click to select a modifier/value combination, press Ctrl/C to 
copy, click Close, click in Modifier, press Ctrl/V to paste, click in Value, type the new value, then click 
Add. 

Click in the list to select an entry, then click Remove to delete or Modify to modify the entry. Click End after 
typing a new value to insert the value. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

WAN Device Properties Modifiers tab 

The WAN Device Properties Modifiers tab specifies modifier properties of a WAN device. Use this tab 
when displaying or modifying the properties of an existing device. 

More Information 
Device Modifiers 
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Device Modifiers 

Device Modifiers overrides the default value for modifiers. To override the default value, do one of the 
following: 

• Type the Modifier name and new Value, then click Add. 

• Click in the list to select a modifier/value combination, click Modify, type the New Value, then click Add. 

Click in the list to Remove a selected entry. Click End after typing a new value to insert the value. Click 
Reset to restore the default value. 

Note  For more information, refer to the SCF ADD DEVICE, SCF ALTER DEVICE, and SCF INFO DEVICE 
commands in the WAN Subsystem Configuration and Management Manual. 

Select WAN Device Type dialog box 

The Select WAN Device Type dialog box specifies the communications subsystem and object type for a 
device. Use this dialog box when adding a new device. 

WAN Process dialog boxes and displays 

Use these dialog boxes to work with WAN processes. 

More Information 
WAN Processes Status display 
WAN Process Properties dialog box 

WAN Processes Status display 

The WAN Processes Status display summarizes the status of WAN processes. If you have selected a 
process in the navigation pane, the process is highlighted in the display pane. 

Process Specifies the name. 
State Specifies the state. 
LDev Specifies the logical device (LDev) number. 
Type Specifies the process type. 
Primary PIN Specifies the primary PIN. 
Backup PIN Specifies the backup PIN. 
Trace Specifies whether the process is being traced. 

Click to select a WAN process, then right-click to display menu commands. 

Note  For more information, refer to the SCF STATUS PROCESS command in the WAN Subsystem 
Configuration and Management Manual. 

WAN Process Properties dialog box 

The WAN Process Properties dialog box specifies the properties of a WAN process. Use this dialog box 
when adding a new process. Use this dialog box when displaying or modifying the properties of an 
existing process. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
WAN Process Properties General tab 
WAN Process Properties Type-Specific Settings tab 

WAN Process Properties General tab 

The WAN Process Properties General tab specifies the general properties of a WAN process. Use this 
dialog box when adding a new process. Use this dialog box when displaying or modifying the properties 
of an existing process. 
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Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
Type 
Name 
IOP Object 
CPUs 
Record Size 

Type 

Type specifies the process type, including the value that represents the NonStop Kernel registered process 
type and subtype. After you specify an SNMP Trap multiplexer, TFTP server, or WANBoot process, the 
Type-Specific Settings tab appears. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

Name 

Name specifies the process name (this should conform to the Tandem Manufacturing Naming Conventions): 

• ConMgr—n is the number of the CPU where the process runs. 

• SNMP Trap multiplexer—n is a sequence number. 

• TFTP server—gg is the group/cabinet number and p is the port number. 

• WANBoot—gg is the group/cabinet number and p is the port number. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands and the Tandem Manufacturing Naming Conventions in the WAN Subsystem Configuration and 
Management Manual. 

IOP Object 

IOP Object specifies the name of the program object file for the process. Replace nn by your system image 
number. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

CPUs 

CPUs specifies the CPU number for the Preferred (primary) and Alternate (backup) processes.. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

Record Size 

Record Size is the configured record size for the process. 

WAN Process Properties Type-Specific Settings tab 

The WAN Process Properties Type-Specific Settings tab specifies the type-specific properties of a WAN 
process. Use this dialog box when adding a new process. Use this dialog box when displaying or 
modifying the properties of an existing process. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

More Information 
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SNMP Trap Multiplexer Process Settings 
TFTP Server Process Settings 
WANBoot Process Settings 

SNMP Trap Multiplexer Process Settings 

To select a TCP/IP process, click in the drop-down list, then click Add. To remove a TCP/IP process, click in 
the list box, then click Remove. Click in the drop-down list to specify an SNMP Agent process. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

TFTP Server Process Settings 

To select a TCP/IP process, click in the drop-down list. Click in Download Location to specify download 
files for the TFTP server process. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

WANBoot Process Settings 

To specify a TCP/IP process, click in the drop-down list. 

Note  For more information, refer to the SCF ADD PROCESS, SCF ALTER PROCESS, and SCF INFO PROCESS 
commands in the WAN Subsystem Configuration and Management Manual. 

WAN Profile dialog boxes and displays 

Use these dialog boxes to work with WAN profiles. 

More Information 
WAN Profiles Status display 
WAN Profile Properties (New) dialog box 
WAN Profile Properties (Existing) dialog box 

WAN Profiles Status display 

The WAN Profiles Status display shows profile names. 

Click to select a WAN profile, then right-click to display menu commands. 

WAN Profile Properties (New) dialog box 

The WAN Profile Properties dialog box specifies the properties of a new profile. Use this dialog box when 
adding a new profile. 

Note  For more information, refer to the SCF ADD PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

More Information 
Name 
Add Profile 
Override Modifiers 

Name 

Name specifies the profile name. 

Note  For more information, refer to the SCF ADD PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

Add Profile 

Add Profile specifies the source of the profile information used as the basis for the new profile. 
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Click From File, then either type a file name, or click Select Type to select the profile used for a 
communications subsystem and object type by using the Select WAN Device Type dialog box. 

Click Like Profile to select from a list of existing profile names. After selecting a profile, optionally click 
Show Profile to display information about the profile in the WAN Profile Properties (Existing) dialog box. 

Note  For more information, refer to the SCF ADD PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

Override Modifiers 

Override Modifiers overrides the default value for modifiers. To override the default value, do one of the 
following: 

• Type the Modifier name and new Value, then click Add. 

• Click Show Profile, click to select a modifier/value combination, press Ctrl/C to copy, click Close, click 
in Modifier, press Ctrl/V to paste, click in Value, type the new value, then click Add. 

Click in the list to select an entry, then click Remove to delete or Modify to modify the entry. 

Note  For more information, refer to the SCF ADD PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

WAN Profile Properties (Existing) dialog box 

The WAN Profile Properties dialog box specifies the properties of an existing profile. Use this dialog box 
when displaying an existing profile. You cannot modify profile properties. 

Note  For more information, refer to the SCF INFO PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

More Information 
Devices Using This Profile 
Device Specific Modifiers 

Devices Using This Profile 

Devices Using This Profile specifies the devices or processes that are using this profile. 

Note  For more information, refer to the SCF INFO PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

Device Specific Modifiers 

Device Specific Modifiers specifies the modifiers in the profile. 

Note  For more information, refer to the SCF INFO PROFILE command in the WAN Subsystem Configuration 
and Management Manual. 

Common SLSA/WAN dialog boxes 

These dialog boxes are used by more than one object in both the SLSA and WAN subsystems. 

More Information 
Subordinates dialog box 
Version dialog box 

Subordinates dialog box 

The Subordinates dialog box aborts, starts, or stops objects, and/or subordinate objects. 

• In the SLSA subsystem, aborts, starts, or stops adapters or SACs, and/or subordinate objects. 

Note  For more information, refer to the SCF ABORT, SCF START, and SCF STOP commands in the LAN 
Configuration and Management Manual. 
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• In the WAN subsystem, aborts, starts, or stops SWAN concentrators or WAN CLIPs, and/or subordinate 
objects. 

Note  For more information, refer to the SCF ABORT, SCF START, and SCF STOP commands in the WAN 
Subsystem Configuration and Management Manual. 

Version dialog box 

The Version dialog box displays version information. 

• In the SLSA subsystem, displays version information for the LANMAN process ($ZZLAN) or the 
LANMON monitor processes ($ZZLAN.#ZLMnn). 

Note  For more information, refer to the SCF VERSION PROCESS command in the LAN Configuration and 
Management Manual. 

• In the WAN subsystem, displays version information for a WAN CLIP or WAN process. 

Note  For more information, refer to the SCF INFO SERVER and SCF VERSION command in the WAN 
Subsystem Configuration and Management Manual. 

System Component Colors 

In the main window, colors indicate system component status. Possible colors are: 

Green System components are started. 
Cyan System components are starting. 
Yellow System components are stopped. 
Red System components are in error. 
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Tasks and tips 

More Information 
Using the toolbar 
Display and select system components in the main window 
Working with nodes 
Working with the SLSA subsystem 
Working with the WAN subsystem 
Common SLSA/WAN Tasks 

Using the toolbar 

The toolbar consists of buttons that provide single-click access to various functions, including some menu 
commands. 

More Information 
Show or hide the toolbar 
Change the size of the toolbar buttons 
Display the previous screen or the next screen 
Change how system components are displayed 
Display detailed information about system components 
Display or modify system component properties 

Show or hide the toolbar 

On the View menu, point to Toolbar Buttons, and then click None. 

Change the size of the toolbar buttons 

 To display large buttons, on the View menu, point to Toolbar, and then click Large. 

 To display small buttons, on the View menu, point to Toolbar, and then click Small. 

Display the previous screen or the next screen 

 To display the screen you just viewed on the right side of the main window, on the toolbar, click the 
Back button. 

 To redisplay the screen you viewed just before clicking the Back button, on the toolbar, click the 
Forward button. 

Change how system components are displayed 

 To display large icons (arranged left to right across the window), on the toolbar, click the Large Icons 
button. 

 To display small icons (arranged left to right across the window), on the toolbar, click the Small Icons 
button. 

 To display small icons in a list (arranged top to bottom down the window), on the toolbar, click the List 
button. 

Error! AutoText entry not defined.Alternatively, on the View menu, click Large Icons, Small Icons, or 
List. 

Display detailed information about system components 

On the toolbar, click the Details button. 

Error! AutoText entry not defined.Alternatively, on the View menu, click Details. 
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Display or modify system component properties 

1 Select a system component in either the navigation pane or the display pane. 

2 On the toolbar, click the Display/Modify Properties button. 

Comms Manager SLSA/WAN displays the Properties dialog box for the selected system component. 

Display and select system components in the main window 

More Information 
Expand and contract a system component hierarchy 
Select and deselect system components 

Expand and contract a system component hierarchy 

You can expand and contract system component hierarchies in the navigation pane (on the left side of the 
main window). 

 Either double-click a component to expand or contract its hierarchy; 

 Or click the plus sign (+) next to a component to expand its hierarchy; click the minus sign (-) to contract 
its hierarchy. 

Select and deselect system components 

You can select and deselect components in the display pane (on the right side of the main window). 

 To select nonadjacent components, click the name of one component. Hold down the Ctrl key and click 
the name of each additional component. 

 To select adjacent components, click the name of the first component in the sequence. Hold down the 
Shift key and click the name of the last component. 

Error! AutoText entry not defined.If you select a component you don't want, hold down the Ctrl key and 
click the component name again. 

Working with nodes 

More Information 
Displaying SLSA/WAN status on a node 
Displaying previous configurations 
Saving the current configuration 

Displaying SLSA/WAN status on a node 

In the navigation pane, click the name of a node. 

Displaying previous configurations 

1 In the navigation pane, click the name of a node. 

2 On the Node menu, click Save Configuration. 

Saving the current configuration 

1 In the navigation pane, click the name of a node. 

2 On the Node menu, click Save Configuration. 

3 Click in the Save Configuration as Version field, and then type a version number. 

4 Click OK. 
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Working with the SLSA subsystem 

More Information 
SLSA Subsystem 
Adapters 
SACs 
PIFs 
LIFs 
Monitor processes 
Tracing 

SLSA Subsystem 

More Information 
Displaying the detailed status of the SLSA subsystem 

Displaying the detailed status of the SLSA subsystem 

In the navigation pane, double-click the name of the node you want to open, and then click SLSA. 

Adapters 

More Information 
Displaying the status of SLSA adapters 
Adding a SLSA adapter 
Displaying the properties of a SLSA adapter 

Displaying the status of SLSA adapters 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click Adapters. 

4 On the View menu, click Details. 

Adding a SLSA adapter 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click Adapters. 

4 On the SLSA Adapters menu, click Add Adapter. 

5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a SLSA adapter 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click Adapters. 

4 Click an adapter name. 

5 On the SLSA Adapter menu, click Properties. 

SACs 

More Information 
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Displaying the status of SACs subordinate to a SLSA adapter 
Displaying the properties of a SAC 
Modifying the properties of a SAC 

Displaying the status of SACs subordinate to a SLSA adapter 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Click an adapter name. 

5 On the View menu, click Details. 

Displaying the properties of a SAC 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Click an adapter name. 

5 Click a SAC name. 

6 On the SLSA SAC menu, click Properties. 

Modifying the properties of a SAC 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Click an adapter name. 

5 Click a SAC name. 

6 On the SLSA SAC menu, click Properties. 

7 Specify properties as required. 

8 Click Close. 

PIFs 

More Information 
Displaying the status of PIFs subordinate to a SAC 
Displaying the detailed status of a PIF 
Displays PIF statistics 
Displaying the properties of a PIF 
Modifying the properties of a PIF 

Displaying the status of PIFs subordinate to a SAC 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Double-click an adapter name. 

5 Click a SAC name. 

6 On the View menu, click Details. 
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Displaying the detailed status of a PIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Double-click an adapter name. 

5 Double-click a SAC name. 

6 Click a PIF name. 

Displays PIF statistics 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Double-click an adapter name. 

5 Double-click a SAC name. 

6 Click a PIF name. 

7 On the SLSA PIF menu, click Statistics. 

Displaying the properties of a PIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Double-click an adapter name. 

5 Double-click a SAC name. 

6 Click a PIF name. 

7 On the SLSA PIF menu, click Properties. 

Modifying the properties of a PIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Adapters. 

4 Double-click an adapter name. 

5 Double-click a SAC name. 

6 Click a PIF name. 

7 On the SLSA PIF menu, click Properties. 

8 Specify properties as required. 

9 Click Close. 

LIFs 

More Information 
Displaying the status of LIFs 
Displaying the detailed status of a LIF 
Adding a LIF 



 

Comms Manager Help The Operations Pack 4.0 Page 81 of 89 

Displaying the properties of a LIF 
Modifying the properties of a LIF 

Displaying the status of LIFs 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click LIFs. 

4 On the View menu, click Details. 

Displaying the detailed status of a LIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click LIFs. 

4 Click a LIF name. 

Adding a LIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click LIFs. 

4 On the SLSA LIFs menu, click Add LIF. 

5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a LIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click LIFs. 

4 Click a LIF name. 

5 On the SLSA LIF menu, click Properties. 

Modifying the properties of a LIF 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click LIFs. 

4 Click a LIF name. 

5 On the SLSA LIF menu, click Properties. 

6 Specify properties as required. 

7 Click Close. 

Monitor processes 

More Information 
Displaying the status of LANMON processes 
Displaying the detailed status of a LANMON process 
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Displaying the status of LANMON processes 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Click Monitors. 

4 On the View menu, click Details. 

Displaying the detailed status of a LANMON process 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click SLSA. 

3 Double-click Monitors. 

4 Click the name of a LANMON process. 

Tracing 

More Information 
Starting, stopping, or modifying a trace 

Starting, stopping, or modifying a trace 

1 Click the object you want to trace. 

You can trace the LANMAN process ($ZZLAN), or a SAC, PIF, or monitor process. 

2 On the menu for that object, click Trace. 

3 In the Trace dialog box for that object, click Start New Trace, Modify Trace, or Stop Existing Trace. 

4 Specify other attributes as required. 

5 Click OK. 

Working with the WAN subsystem 

More Information 
WAN manager process 
SWAN concentrators 
CLIPs 
Paths 
Tasks 
Devices 
Processes 
Profiles 

WAN manager process 

More Information 
Displaying objects under the WAN manager process 
Displaying the properties of the WAN manager process 
Specifying the CPU number for the primary WAN manager process 

Displaying objects under the WAN manager process 

In the navigation pane, double-click the name of the node you want to open, and then click WAN. 

Displaying the properties of the WAN manager process 

1 In the navigation pane, double-click the name of the node you want to open. 
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2 Click WAN. 

3 On the WAN Subsystem menu, click Properties. 

Specifying the CPU number for the primary WAN manager process 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Click WAN. 

3 On the WAN Subsystem menu, click Primary. 

SWAN concentrators 

More Information 
Displaying the status of SWAN concentrators 
Adding a SWAN concentrator 
Displaying the properties of a SWAN concentrator 
Modifying the properties of a SWAN concentrator 

Displaying the status of SWAN concentrators 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click SWANs. 

4 On the View menu, click Details. 

Adding a SWAN concentrator 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click SWANs. 

4 On the SWAN Concentrators menu, click Add SWAN. 

5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a SWAN concentrator 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Click a SWAN name. 

5 On the SWAN Concentrator menu, click Properties. 

Modifying the properties of a SWAN concentrator 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Click a SWAN name. 

5 On the SWAN Concentrator menu, click Properties. 

6 Specify properties as required. 

7 Click Close. 
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CLIPs 

More Information 
Displaying the status of WAN CLIPs subordinate to a SWAN concentrator 
Adding a CLIP 
Displaying objects under a WAN CLIP 

Displaying the status of WAN CLIPs subordinate to a SWAN concentrator 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Click a SWAN name. 

Adding a CLIP 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Click a SWAN name. 

5 On the SWAN Concentrator menu, click Add CLIP. 

6 Specify properties as required. 

7 Click Close. 

Displaying objects under a WAN CLIP 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Click a CLIP name. 

Paths 

More Information 
Displaying the status of SWAN paths 
Adding a new path 
Displaying the properties of a path 
Modifying the properties of a path 

Displaying the status of SWAN paths 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Click Paths. 
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Adding a new path 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Double-click Paths. 

7 On the SWAN Paths menu, click Add Path. 

Displaying the properties of a path 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Double-click Paths. 

7 Click a path name. 

8 On the SWAN Path menu, click Properties. 

Modifying the properties of a path 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Double-click Paths. 

7 Click a path name. 

8 On the SWAN Path menu, click Properties. 

9 Specify properties as required. 

10 Click Close. 

Tasks 

More Information 
Displaying the status of SWAN tasks 
Displaying the properties of a task 
Modifying the properties of a task 

Displaying the status of SWAN tasks 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 
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5 Double-click a CLIP name. 

6 Click Tasks. 

Displaying the properties of a task 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Double-click Tasks. 

7 Click a task name. 

8 On the SWAN Task menu, click Properties. 

Modifying the properties of a task 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click SWANs. 

4 Double-click a SWAN name. 

5 Double-click a CLIP name. 

6 Double-click Tasks. 

7 Click a task name. 

8 On the SWAN Task menu, click Properties. 

9 Specify properties as required. 

10 Click Close. 

Devices 

More Information 
Displaying the status of WAN devices 
Adding a new device 
Displaying the properties of a device 
Modifying the properties of a device. 

Displaying the status of WAN devices 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Devices. 

4 On the View menu, click Details. 

Adding a new device 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Devices. 

4 On the WAN Devices menu, click Add Device. 
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5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a device 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click Devices. 

4 Click a device name. 

5 On the WAN Device menu, click Properties. 

Modifying the properties of a device. 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click Devices. 

4 Click a device name. 

5 On the WAN Device menu, click Properties. 

6 Specify properties as required. 

7 Click Close. 

Processes 

More Information 
Displaying the status of WAN processes 
Adding a new WAN process 
Displaying the properties of a WAN process 
Modifying the properties of a WAN process 

Displaying the status of WAN processes 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Processes. 

4 On the View menu, click Details. 

Adding a new WAN process 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Processes. 

4 On the WAN Processes menu, click Add Process. 

5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a WAN process 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click Processes. 



 

Comms Manager Help The Operations Pack 4.0 Page 88 of 89 

4 Click a process name. 

5 On the WAN Processes menu, click Properties. 

Modifying the properties of a WAN process 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Double-click Processes. 

4 Click a process name. 

5 On the WAN Process menu, click Properties. 

6 Specify properties as required. 

7 Click Close. 

Profiles 

More Information 
Displaying profile names 
Adding a new profile 
Displaying the properties of a profile 

Displaying profile names 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Profiles. 

Adding a new profile 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Profiles. 

4 On the WAN Profiles menu, click Add Profile. 

5 Specify properties as required. 

6 Click Close. 

Displaying the properties of a profile 

1 In the navigation pane, double-click the name of the node you want to open. 

2 Double-click WAN. 

3 Click Profiles. 

4 On the WAN Profiles menu, click Properties. 

Common SLSA/WAN Tasks 

More Information 
Aborting, starting, stopping objects, and/or subordinate objects 
Displaying version information 

Aborting, starting, stopping objects, and/or subordinate objects 

1 Click the object you want to abort, start, or stop. 
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 In the SLSA subsystem, this is an adapter or SAC. 

 In the WAN subsystem, this is a SWAN concentrator or WAN CLIP. 

2 On the menu for that object, click Abort, Start, or Stop. 

3 In the Subordinates dialog box for that object, click None, Only, or All. 

4 Click OK. 

Displaying version information 

1 Click the process for which you want to find out version information. 

 In the SLSA subsystem, this is the LANMAN process ($ZZLAN) or the LANMON monitor processes 
($ZZLAN.#ZLMnn. 

 In the WAN subsystem, this is a WAN CLIP or WAN process. 

2 On the menu for that object, click Version. 

3 Click Close. 
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